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CAUTION! 

AFT Fathom is a sophisticated pipe flow analysis program designed for 
qualified engineers with experience in pipe flow analysis and should not 
be used by untrained individuals. AFT Fathom is intended solely as an 
aide for pipe flow analysis engineers and not as a replacement for other 
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engineering judgment. All data generated by AFT Fathom should be 
independently verified with other engineering methods. 

AFT Fathom is designed to be used only by persons who possess a level 
of knowledge consistent with that obtained in an undergraduate 
engineering course in the analysis of pipe system fluid mechanics and are 
familiar with standard industry practice in pipe flow analysis. 

AFT Fathom is intended to be used only within the boundaries of its 
engineering assumptions. The user should consult the AFT Fathom Help 
system for a discussion of all engineering assumptions made by AFT 
Fathom. 

 
 

 

Information in this document is subject to change without notice. No part of this Quick 
Start Guide may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, for any purpose, without the express written permission of Applied Flow 
Technology. 

 

© 2018 Applied Flow Technology Corporation. All rights reserved. 

Printed in the United States of America. 

First Printing. 

 

“AFT Fathom”, “Applied Flow Technology”, “Dynamic solutions for a fluid world”, and 
the AFT logo are trademarks of Applied Flow Technology Corporation.  

Excel and Windows are trademarks of Microsoft Corporation. Intelliquip is a trademark 
of Intelliquip, LLC. Chempak is a trademark of Madison Technical Software, Inc. 
CAESAR II, SmartPlant, CADWorx, and PDS are trademarks of Intergraph Corporation. 
ROHR2 is a trademark of SIGMA Ingenieurgesellschaft mbH. AutoCAD Plant 3D is a 
trademark of Autodesk, Inc.



Contents 

1. Introducing AFT Fathom ................................................ 1 

Modeling capabilities ................................................................................ 2 

Standard version capabilities .............................................................. 2 

Add-on module capabilities (optional) ............................................... 2 

Thermophysical property data .................................................................. 3 

Engineering assumptions in AFT Fathom ................................................ 3 

AFT Fathom Primary Windows ............................................................... 4 

Input windows .................................................................................... 4 

Output windows ................................................................................. 4 

2. Sizing a Pump Example ................................................. 7 

Topics covered .......................................................................................... 7 

Required knowledge ................................................................................. 7 

Model file .................................................................................................. 8 

Problem statement .................................................................................... 8 

Step 1. Start AFT Fathom ......................................................................... 8 

The Workspace window ............................................................ 12 

Unpinning the Quick Access Panel ........................................... 13 

Step 2. Lay out the model ....................................................................... 13 

A. Place a reservoir .......................................................................... 13 

Objects and ID numbers ............................................................ 13 

Editing on the Workspace .......................................................... 14 

B. Place the other junctions .............................................................. 15 

C. Draw a pipe between J1 and J2 ................................................... 16 

Reference positive flow direction .............................................. 18 

D. Add the remaining pipe ............................................................... 18 

Step 3. Complete the checklist requirements .......................................... 19 

A. Specify solution control ............................................................... 20 

B. Specify system properties ............................................................ 20 

C. Specify cost settings .................................................................... 22 

Step 4. Define the model components (checklist item #3) ..................... 22 



ii   AFT Fathom 10 Quick Start Guide 

Object status............................................................................... 22 

Showing undefined objects ........................................................ 22 

A. Define Reservoir J1 ..................................................................... 23 

Using the folder tabs in the Properties windows ....................... 25 

The Inspection feature ............................................................... 26 

B. Define other junctions ................................................................. 27 

C. Define Pipe P1 ............................................................................. 28 

The Pipe Properties window ...................................................... 28 

D. Define Pipe P2 ............................................................................. 29 

E. Check pipes and junctions ........................................................... 30 

F. Review Model Data ..................................................................... 30 

Reviewing input in the Model Data window ............................. 30 

Step 5. Run the solver ............................................................................. 31 

Step 6. Customize the output .................................................................. 32 

Step 7. Review the output ....................................................................... 33 

A. Modify the output format ............................................................ 36 

B. View the Visual Report ............................................................... 37 

C. Graph the results .......................................................................... 39 

Step 8. Add a pump curve ....................................................................... 43 

Conclusion .............................................................................................. 47 

3. Spray Discharge System Example .............................. 49 

Topics covered ........................................................................................ 49 

Required knowledge ............................................................................... 49 

Model file ................................................................................................ 49 

Problem statement .................................................................................. 50 

Step 1. Start AFT Fathom ....................................................................... 50 

Step 2. Specify system properties ........................................................... 50 

Step 3. Build the model........................................................................... 50 

A. Place the pipes and junctions ....................................................... 50 

B. Enter the pipe data ....................................................................... 51 

C. Enter the spray data (J1-J8) ......................................................... 54 

D. Enter other junction data ............................................................. 57 

J9 - Assigned Pressure ............................................................... 57 



Table of Contents   iii 

J10 - Branch ............................................................................... 57 

J11 - Branch ............................................................................... 57 

J12 - Dead End ........................................................................... 57 

E. Check if the pipe and junction data is complete .......................... 57 

Step 4. Run the model and iterate ........................................................... 57 

Step 5. Graph the results ......................................................................... 59 

Analysis summary .................................................................................. 61 

Isometric Pipe Drawing Mode ................................................................ 62 

4. Freon Delivery System with Heat Transfer Example . 67 

Topics covered ........................................................................................ 67 

Required knowledge ............................................................................... 67 

Model file ................................................................................................ 68 

Problem statement .................................................................................. 68 

Step 1. Start AFT Fathom ....................................................................... 68 

Step 2. Specify system properties ........................................................... 68 

Step 3. Build the model........................................................................... 69 

A. Place the pipes and junctions ....................................................... 69 

B. Enter the pipe data ....................................................................... 70 

C. Enter junction data ....................................................................... 74 

J1 - Supply Reservoir ................................................................. 74 

J7 - Receiving Reservoir ............................................................ 74 

J3, J5 - Branch Junctions ........................................................... 74 

J2 - Pump Junction ..................................................................... 74 

J4, J6 - Heat Exchangers ............................................................ 75 

D. Check if the pipe and junction data is complete .......................... 77 

Step 4. Create a scenario for each refrigerant ......................................... 77 

Step 5. Set up the R11 case ..................................................................... 79 

Step 6. Run the R11 case ........................................................................ 79 

Step 7. Examine the R11 results ............................................................. 79 

Step 8. Set up the R123 case ................................................................... 82 

Step 9. Run the R123 case ...................................................................... 82 

Step 10. Examine the R123 results ......................................................... 82 

Analysis summary .................................................................................. 84 



iv   AFT Fathom 10 Quick Start Guide 

5. AFT Fathom Add-on Modules Examples .................... 85 

Topics covered ........................................................................................ 85 

Required knowledge ............................................................................... 85 

Model files .............................................................................................. 86 

Problem statements ................................................................................. 86 

GSC Example ............................................................................ 86 

XTS Example ............................................................................. 86 

SSL Example ............................................................................. 86 

Step 1. Start AFT Fathom ....................................................................... 86 

Step 2. Specify system properties ........................................................... 87 

Step 3. Build the model........................................................................... 87 

A. Place the pipes and junctions ....................................................... 87 

B. Enter the pipe data ....................................................................... 87 

C. Enter the junction data ................................................................. 88 

J1, J9 - Reservoirs ...................................................................... 88 

J2 - Pump ................................................................................... 89 

J3 - Three-Way Valve ................................................................ 90 

J4, J7, J8 - Branch Junctions ...................................................... 90 

J5, J6 - Heat Exchangers ............................................................ 90 

D. Check if the pipe and junction data is complete .......................... 90 

GSC problem statement .......................................................................... 91 

GSC Step 1. Create a scenario for GSC case .......................................... 91 

GSC Step 2. Activate the GSC Module .................................................. 91 

GSC Step 3. Open the Goal Seek and Control Manager ........................ 91 

GSC Step 4. Add a variable .................................................................... 92 

GSC Step 5. Add a goal .......................................................................... 93 

GSC Step 6. Activate GSC analysis ....................................................... 96 

GSC Step 7. Run the model .................................................................... 96 

GSC Step 8. Examine the results ............................................................ 98 

GSC analysis summary ........................................................................... 98 

XTS problem statement .......................................................................... 99 

XTS Step 1. Create a scenario for XTS case .......................................... 99 

XTS Step 2. Activate the XTS Module .................................................. 99 

XTS Step 3. Modify the existing model ................................................. 99 



Table of Contents   v 

A. Enter the new junction and system data ...................................... 99 

J9 - Reservoir ............................................................................. 99 

J3 - Three-Way Valve .............................................................. 100 

B. Check if the pipe and junction data is complete ........................ 100 

XTS Step 4. Specify transient output time format ................................ 100 

XTS Step 5. Activate transient analysis ................................................ 100 

XTS Step 6. Open transient control ...................................................... 101 

XTS Step 7. Set up the pump transient ................................................. 103 

XTS Step 8. Run the model .................................................................. 104 

XTS Step 9. Examine the transient results............................................ 105 

XTS analysis summary ......................................................................... 111 

SSL problem statement ......................................................................... 111 

SSL Step 1. Start AFT Fathom ............................................................. 111 

SSL Step 2. Specify system properties ................................................. 112 

SSL Step 3. Build the model ................................................................. 113 

A.  Place the pipes and junctions ................................................ 113 

B.  Enter the pipe data ................................................................ 113 

C.  Enter the junction data .......................................................... 114 

J1 - Reservoir ........................................................................... 114 

J4 - Reservoir ........................................................................... 114 

J2 - Pump ................................................................................. 114 

J3 - Elbow ................................................................................ 114 

D.  Check if the pipe and junction data is complete ................... 115 

SSL Step 4. Run the model ................................................................... 115 

SSL Step 5. Examine the results ........................................................... 115 

SSL analysis summary .......................................................................... 118 

6. Other AFT Fathom Capabilities ................................. 119 

Index ................................................................................ 123 

 

 

 



vi   AFT Fathom 10 Quick Start Guide 

 

 

 

 

 

 



C H A P T E R  1  

Introducing AFT Fathom 

Welcome to AFT Fathom™ 10, Applied Flow Technology’s powerful 
pipe and duct flow modeling tool. With AFT Fathom you can model 
incompressible flow in complex pipe and duct networks, including 
coupled heat transfer in pipes and ducts, heat exchangers and pumps, and 
the resultant effect on fluid properties such as viscosity.  

AFT Fathom 10 has four available add-on modules, which extend AFT 
Fathom’s extensive modeling capabilities into new areas. The modules 
can be used individually or together. 

 The Extended Time Simulation (XTS) module allows the 
engineer to model time varying system behavior.  

 The Goal Seek & Control (GSC) module allows the engineer to 
perform multivariable goal seeking and simulate control system 
functions.  

 The Settling Slurry (SSL) module allows the engineer to perform 
the complex property and system interaction calculations 
associated with settling slurry flows.  

 The Automated Network Sizing (ANS) module automates the 
process of sizing pipes and ducts in a complex network based on 
required conditions, such as maximum pressure or minimum 
flow, to reduce cost or weight. 

AFT Fathom is a proven tool which provides the engineer with an 
extremely broad and powerful feature set ready to tackle the most 
demanding analysis problems. 
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Modeling capabilities 

AFT Fathom can be used to model a wide variety of engineering 
systems. AFT Fathom consists of the standard version plus four optional 
add-on modules. 

Standard version capabilities 

 Open and closed (recirculating) systems 

 Network systems that branch or loop, with no limit on the number of 
loops 

 Pressure fed systems and gravity fed systems 

 Pumped systems, including multiple pumps in parallel or in series 

 Pumps with variable speed, controlled pressure, controlled flow, 
viscosity corrections, and multiple stages with takeoff flow 

 Systems with pressure and/or flow control valves 

 Systems with valves closed and pumps turned off 

 Heat transfer and system energy balance 

 Systems with variable density and viscosity 

 Multiple design cases in a single model file 

 Non-Newtonian fluid behavior 

 Cost calculation of pump energy usage 

Add-on module capabilities (optional) 

 Transient modeling (XTS) 

 Pump starting and stopping over time (XTS) 

 Valve opening and closing over time (XTS) 

 Tank liquid level changes automatically calculated (XTS) 

 Multi-variable goal seeking and control simulation (GSC) 

 System performance for settling slurry calculations (SSL) 

 Automated design of a piping network (ANS) 
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AFT Fathom provides hundreds of standard loss models for pipe system 
components and allows you to enter your own loss data. Variable loss 
models that depend on flow are supported. 

AFT Fathom's powerful solution engine is based on standard techniques 
used for many years in industry. The Newton-Raphson method is used to 
solve the fundamental equations of pipe flow that govern mass and 
momentum balance. Solutions are obtained by iteration, and matrix 
methods optimized for speed are employed to obtain convergence. 

Thermophysical property data 

AFT Fathom derives physical properties from one of five sources. The 
first is the standard AFT Fathom set of incompressible fluids which 
contains data for about 70 common fluids (called AFT Standard).  

The second is User Specified Fluid, for which data is provided by the 
user. The third is water (and steam) data from the ASME Steam tables. 

The fourth is the NIST REFPROP database, first introduced in AFT 
Fathom 10. REFPROP is licensed from the National Institute of 
Standards and Technology and is included in AFT Fathom. REFPROP 
has a database of approximately 150 fluids and supports user specified 
fluid mixtures. AFT Fathom is restricted to non-reacting mixture 
calculations. 

The fifth is the Chempak™ database, first introduced in AFT Fathom 4. 
Chempak is licensed from Madison Technical Software and is offered as 
an optional add-on to AFT Fathom. Chempak has a database of 
approximately 700 fluids and supports user specified fluid mixtures. AFT 
Fathom is restricted to non-reacting mixture calculations. 

Engineering assumptions in AFT Fathom 

AFT Fathom is based on the following fundamental fluid mechanics 
assumptions: 

 Incompressible flow (single phase) 

 One-dimensional flow 

 No chemical reactions 

 Steady-state conditions (the XTS module allows transient modeling) 
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AFT Fathom Primary Windows 

The AFT Fathom window has five subordinate windows that work in an 
integrated fashion. Each is located on a separate, moveable tab. You 
work exclusively from one of these windows at all times. For this reason, 
they are referred to as Primary Windows. 

Of the five Primary Windows, two are input windows, two are output 
windows, and one displays output and input information. Figure 1.1 
shows the relationship between the Primary Windows.  

 

 

Figure 1.1 Primary Window workflow in AFT Fathom 

Input windows 

The two windows that function exclusively as input windows are the 
Workspace window and the Model Data window. These two windows, 
one graphical and the other text-based, work together to process model 
input data with immense flexibility. The tools provided in these two 
windows allow you to model a large variety of pipe networks. 

The Visual Report window can function in support of both input and 
output data. As an input window, it allows you to see the input data 
superimposed on the pipe system schematic created on the Workspace. 

Output windows 

The two windows that function exclusively as output windows are the 
Output window and the Graph Results window. The Output window is 
text-based, while the Graph Results window is graphical. These two 
windows offer a powerful and diverse range of features for reviewing 
analysis results for modeling errors, gaining a deeper understanding of 
the pipe system's flow behavior, and preparing the results for 
documentation.  
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As an output window, Visual Report allows you to see the output results 
superimposed on the pipe system schematic created on the Workspace. 

The five Primary Windows form a tightly integrated, highly efficient 
system for entering, processing, analyzing, and documenting 
incompressible flow analyses of pipe networks. 

Note: AFT Fathom will support dual monitors. You can click and drag 
any of the five primary window tabs off of the main Fathom window.  
Once you drag one of the Primary Windows off of the Fathom window, 
you can move it anywhere you like on your screen, including onto a 
second monitor in a dual monitor configuration. To add the Primary 
Window back to the main Fathom primary tab window bar, simply click 
the X button in the upper right of the Primary Window. 
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C H A P T E R  2  

Sizing a Pump Example 

Summary 

This chapter is intended to give you the big picture of AFT Fathom's 
layout and structure. A number of other example model discussions are 
included in a Help file distributed with AFT Fathom called 
FathomExamples.chm. It can be opened from the Help menu by 
choosing “Show Examples”. 

This example demonstrates a sample calculation to size a pump for a 
specified system. 

Topics covered 

 Model building basics 

 Entering Pipe and Junction data 

 Specifying System Properties  

 Specifying Output Control 

 Creating Visual Reports 

 Graphing results 

 Sizing a pump and entering pump curve data 

Required knowledge 

No prior knowledge is required for this example. 
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Model file 

This example uses the following file, which is installed in the Examples 
folder as part of the AFT Fathom installation: 

 Sizing a Pump.fth - AFT Fathom model file 

This example is provided in the model file under the English Units 
scenario. It is also provided in Metric units under the Metric Units 
scenario. 

This example will require you to build the model from scratch to help 
familiarize yourself with the steps required to build a complete model in 
AFT Fathom. Therefore, use this example model file as a reference only. 

Problem statement 

For this problem, a pump is to be used to transfer water from a supply 
reservoir to a holding reservoir at the top of a hill. The system consists of 
a supply reservoir, a pump, a discharge reservoir, and two pipes. 

The first pipe from the supply reservoir to the pump is 10 feet long, and 
the second pipe leading from the pump to the discharge reservoir is 990 
feet long. Both pipes are Steel - ANSI, 4 inch, STD (schedule 40). 
Constant fluid properties are assumed. 

The supply reservoir has a surface pressure of 0 psig, and the liquid 
surface is at an elevation of 10 feet. The discharge reservoir has a surface 
pressure of 0 psig, and the liquid surface is at an elevation of 200 feet. 
The pipes for both reservoirs connect to the reservoirs at a depth of 10 
feet. 

What is the head requirement for a pump to supply flow in this system at 
500 gal/min? 

Step 1. Start AFT Fathom 

 To start AFT Fathom, click Start on the Windows taskbar, choose All 
Programs, then AFT Products, and then AFT Fathom. (This refers to the 
standard menu items created by a setup. You may have chosen to specify 
a different menu item).  
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As AFT Fathom is started, the Fathom Startup Window appears, as 
shown in Figure 2.1. This window provides you with several options you 
can choose before you start building a model. 

 

Figure 2.1  Startup Window with Modeling Preferences Collapsed 

Some of the actions available are: 

 Open a recent model, browse to a model, or browse to an Example 

 Activate an Add-on Module 

 Select ASME Water or a recently used fluid to be the Working Fluid 

 Review or modify Modeling Preferences 

 Select a Unit System 

 Filter units to include Common Only or Common Plus Selected 
Industries 

 Choose a Grid Style 

 Select a Default Pipe Material 

 Access other Resources, such as Quick Start Guides, Help Files, and 
Video Tutorials 

Review or 
Modify Modeling 

Preferences 



10   AFT Fathom 10 Quick Start Guide 

If this is the first time that you have started AFT Fathom, Modeling 
Preferences will be expanded in the middle section of the Startup 
Window, as shown in Figure 2.2. If this is not the first time that you have 
started AFT Fathom, the Startup Window will appear with Modeling 
Preferences collapsed, as shown in Figure 2.1. 

When collapsed, you can view your current Modeling Preferences at the 
bottom of Start a New Model. To further review or adjust your 
preferences, click the “Modify>>” button (see Figure 2.1).  

 

Figure 2.2  Startup Window with Modeling Preferences Expanded 

With Modeling Preferences expanded, as in Figure 2.2, select “Both with 
US Defaults” under Unit System. Select “Common Only” under Filter to 
show only commonly used units, instead of “All Units.”  

You can “Show Sample Units” to see which units will be included based 
on your selections, as shown in Figure 2.3.  
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Figure 2.3  Show Sample Units with “Common Only” Selected 

The other Filter option is “Common Plus Selected Industries,” which will 
add units from the industries that you select. Once you have finished 
modifying your Modeling Preferences, click “Remember My Preferences 
and Hide.” Now that your unit preferences are set, click “Start Building 
Model.” 

Hide Sample 
Units
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The Workspace window is the initial active (large) window, as seen in 
Figure 2.4. The five tabs in the AFT Fathom window represent the five 
primary windows. Each Primary Window contains its own toolbar that is 
displayed directly beneath the Primary Window tabs. 

The Workspace window 

The Workspace window is the primary vehicle for building your model. 
This window has three main areas: the Toolbox, the Quick Access Panel, 
and the Workspace itself. The Toolbox is the bundle of tools on the far 
left. The Quick Access Panel is displayed on the far right. It gives easy 
access to a variety of features such as the Scenario Manager, the 
Checklist Panel, and viewing pipe and junction properties. The 
Workspace takes up the rest of the window. 

  

Figure 2.4  The Workspace window is where the model is built. 
The other four Primary Windows are found on the tabs 
along the top of the Workspace. The Status Bar shows 
the model status 

Primary Window Tabs 

Status Bar 
Workspace 
Zoom Tools 

Float Toolbox 

Toolbox 

Workspace  
Overview 

Map 

Quick Access Panel 

Workspace 

Quick Access Panel Pin 

Scenario Manager in 
Quick Access Panel 

Checklist Panel 
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You will build your pipe flow model on the Workspace using the 
Toolbox tools. At the top of the Toolbox is the Float Toolbar. From here, 
you can choose the location of the Toolbox in reference to the 
Workspace by specifying Dock Left, Float, or Dock Right. Below the 
Float Toolbar are two drawing tools. The Pipe Drawing tool, on the 
upper left, is used to draw new pipes on the Workspace. Next to this tool 
is the Annotation tool. The Annotation tool allows you to create 
annotations and auxiliary graphics. 

Below the two drawing tools are twenty-three icons that represent the 
different types of junctions available in AFT Fathom. Junctions are 
components that connect pipes and influence the pressure or flow 
behavior of the pipe system. The twenty-three junction icons can be 
dragged from the Toolbox and dropped onto the Workspace. 

When you hold your mouse pointer over any of the Toolbox tools, a 
ToolTip identifies the tool's function. 

Unpinning the Quick Access Panel 

By default, the Quick Access Panel is pinned to the Workspace window 
so that it is constantly displayed. The Quick Access Panel can be 
unpinned so that it is only displayed when the mouse is moved over the 
tab displayed on the right edge of the Workspace window. Unpin the 
Quick Access Panel by clicking on the picture of the pin displayed in the 
top right corner of the Quick Access Panel (see Figure 2.4). For the 
remainder of the examples in this guide, the Quick Access Panel will be 
unpinned. 

Step 2. Lay out the model 

To lay out the pump sizing model, you will place three junctions on the 
Workspace. Then you will connect the junctions with pipes. 

A. Place a reservoir 

 To start, drag a Reservoir junction from the Toolbox and drop it on 
the Workspace. Figure 2.5a shows the Workspace with one reservoir. 

Objects and ID numbers 

Items placed on the Workspace are called objects. All objects are derived 
directly or indirectly from the Toolbox. AFT Fathom uses three types of 
objects: pipes, junctions and annotations.  
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All pipe and junction objects on the Workspace have an associated ID 
number. For junctions, this number is, by default, placed directly above 
the junction and prefixed with the letter “J”. Pipe ID numbers are 
prefixed with the letter “P”. You can optionally choose to display either 
or both the ID number and the name of a pipe or junction. You also can 
drag the ID number/name text to a different location to improve 
visibility.  

The reservoir you have created on the Workspace will take on the default 
ID number of 1. You can change this to any desired integer greater than 
zero but less than 100,000. 

Editing on the Workspace 

Once on the Workspace, junction objects can be moved to new locations 
and edited using the features on the Edit menu. Cutting, copying, and 
pasting are all supported. A single level of undo is available for all 
editing operations. 

 

Figure 2.5a Walk through model with first junction placed 
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B. Place the other junctions 

Drag a Pump junction from the Toolbox and drop it somewhere to the 
right of the Reservoir junction (see Figure 2.5b).  

If a new junction type you want to add already exists on the Workspace, 
you have the option of duplicating that junction. You do this by choosing 
Duplicate from the Edit menu. Either duplicate the first reservoir or drag 
a new Reservoir junction onto the Workspace. Place the new reservoir 
somewhere to the right of the Pump junction (see Figure 2.5b).  

Note: The relative location of objects in AFT Fathom is not important. 
Distances and heights are defined through dialog boxes. These relative 
object locations on the Workspace establish the connectivity of the 
objects, but have no bearing on the actual length or elevation 
relationships. The Isometric Pipe Drawing Mode (see Chapter 3) can be 
used to visually represent the three-dimensional nature of a system. 

If the icons do not line up exactly, the calculations will not be affected. 
However, your model may have a nicer appearance if the icons line up. 
You can align the icons by using the align features selected from the 
Arrange menu. 

Your model should now appear similar to that shown in Figure 2.5b.  

 

Figure 2.5b Walk through model with all junctions placed 
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Before continuing, save the work you have done so far. Choose Save 
As from the File menu and enter a file name (Sizing a Pump, perhaps) 
and AFT Fathom will append the “.fth” extension to the file name. 

C. Draw a pipe between J1 and J2 

Now that you have three junctions, you need to connect them with pipes. 

 To create a pipe, click the Pipe Drawing Tool icon on the Toolbox. The 
pointer will change to a crosshair when you move it over the Workspace. 
Draw a pipe below the junctions, similar to that shown in Figure 2.5c. 

The pipe object on the Workspace has an ID number (P1) that is shown 
near the center of the pipe.  

 

Figure 2.5c Walk through model with first pipe drawn 

 To place the pipe between J1 and J2, use the mouse to grab the pipe in 
the center, drag it so that its left endpoint falls within the J1 Reservoir 
icon, then drop it there (see Figure 2.5d). Next, grab the right endpoint of 
the pipe and stretch the pipe, dragging it until the endpoint terminates 
within the J2 Pump icon (see Figure 2.5e). 
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Figure 2.5d Walk through model with first pipe partially connected 

 

Figure 2.5e Walk through model with first pipe connected 
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Reference positive flow direction  

There is an arrow on each pipe that indicates the reference positive flow 
direction for the pipe. AFT Fathom assigns a flow direction 
corresponding to the direction in which the pipe is drawn. 

You can reverse the reference positive flow direction by choosing 
Reverse Direction from the Arrange menu or selecting the Reverse Pipe 
Direction button on the Workspace Toolbar. 

In general, the reference positive flow direction is used for reference 
purposes only and need not be the actual flow direction. However, when 
used with pumps and certain other junction types, the pipes must be in 
the correct flow direction because that is how AFT Fathom determines 
which side is suction and which is discharge. If the reference positive 
flow direction is the opposite of that obtained by the Solver, the output 
will show the flow rate as a negative number.   

D. Add the remaining pipe 

A faster way to add a pipe is to draw it directly between the desired 
junctions. 

 Activate the Pipe Drawing Tool again, position the mouse pointer on 
the J2 Pump, then press and hold the left mouse button. Stretch the pipe 
across to the J3 Reservoir, and then release the mouse button. Your 
model should now look similar to Figure 2.5f. 

At this point, all the objects in the model are graphically connected. Save 
the model by selecting Save in the File menu or by clicking on the 
diskette button on the Main Toolbar. 
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Figure 2.5f Walk through model with all pipes and junctions placed 

Note: Some users find it desirable to lock objects to the Workspace once 
they have been placed. This prevents accidental movement and 
disruption of the connections. You can lock all the objects by choosing 
Select All from the Edit menu, then selecting Lock Object from the 
Arrange menu. The lock button on the Workspace Toolbar will appear 
depressed, indicating it is in an enabled state, and will remain so as long 
as any selected object is locked. Alternatively, you can use the grid 
feature and snap to grid. The grid options can be modified through the 
User Options window.  

Step 3. Complete the checklist requirements 

 Next, click the checkmark on the Main Toolbar at the top of the AFT 
Fathom window. This opens the Checklist window (see Figure 2.6). The 
Checklist window (also simply called the Checklist) contains four or 
more items depending on which modules you may be using. Each item 
needs to be completed before AFT Fathom allows you to run the Solver. 
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The state of each Checklist item can also be seen by clicking the Model 
Status light on the Status Bar at the bottom right corner of the AFT 
Fathom window (see Figure 2.4). This will cause the Checklist to be 
displayed in the Quick Access Panel window to the right of the 
Workspace. The Checklist can also be opened from the View menu. 
Once the Checklist is complete, the Model Status light in the lower right 
corner turns from red to green. 

A. Specify solution control 

The first Checklist item, Specify Solution Control, is always checked 
when you start AFT Fathom because AFT Fathom assigns default 
solution control parameters. In general, you do not need to adjust these 
values. If necessary, you can make adjustments by opening the Solution 
Control window from the Analysis menu. 

 

Figure 2.6 The Checklist tracks the model’s status. You will see 
additional Checklist items if any of the add-on 
modules are in use 

B. Specify system properties 

The second item on the Checklist is Specify System Properties. To 
complete this item, you must open the System Properties window. This 
window allows you to select your fluid(s) as well as gravitational 
acceleration and atmospheric pressure.  

You can directly enter density and viscosity data (using User Specified 
Fluid), select a fluid from the standard AFT Fathom fluid database (AFT 
Standard), or select Water Data from ASME Steam Tables. Additionally, 
you can select from fluids and/or create mixtures using the NIST 
REFPROP database (included in AFT Fathom) or the Chempak database 
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(an optional add-on to AFT Fathom). Users can also add their own 
custom fluids to the AFT Standard database.  

 

Figure 2.7 The System Properties window lets you select fluids 
for the model and create mixtures 

 Select System Properties from the Analysis menu to open the System 
Properties window (see Figure 2.7). For this example, use the AFT 
Standard database and select “Water at 1 atm” in the upper list, then click 
the “Add to Model” button. Enter a temperature of 70 deg. F and click 
the Calculate Properties button. 

 Open the Checklist by clicking the status light on the Status Bar and 
you should now see the second item checked off. 
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C. Specify cost settings 

Skipping the third Checklist item for the moment, the fourth Checklist 
item, Cost Settings, is always deactivated when you start AFT Fathom. 
The Cost Settings window provides a way to define energy costs, and the 
types of costs to be included in the cost calculations. By default, the cost 
calculation is turned off, and hence nothing further is required for this 
Checklist item. 

Step 4. Define the model components (checklist item #3) 

The third item on the Checklist, “Define All Pipes and Junctions”, is not 
as straightforward to satisfy as the other three. This item includes the 
required input data and connectivity for all pipes and junctions. 

Object status 

Every pipe and junction has an object status. The object status tells you 
whether the object is defined according to AFT Fathom's requirements. 
To see the status of the objects in your model, click the light bulb icon on 
the Workspace Toolbar (alternatively, you could choose “Show Object 
Status” from the View menu). Each time you click the light bulb, “Show 
Object Status” is toggled on or off. 

When “Show Object Status” is on, the ID numbers for all undefined 
pipes and junctions are displayed in red on the Workspace. Objects that 
are completely defined have their ID numbers displayed in black. (These 
colors are configurable through User Options from the Tools menu.) 

Because you have not yet defined the pipes and junctions in this sample 
problem, all the objects' ID numbers will change to red when you turn on 
“Show Object Status”. 

Showing undefined objects 

Another useful feature is the Undefined Objects list (Figure 2.8). This 
can be opened from the View menu by clicking on “List Undefined 
Objects…” or by clicking on “Define All Pipes and Junctions” on the 
Checklist. Here all objects with incomplete information are listed. 
Clicking on an undefined pipe or junction will display the property data 
that is missing. Click the Close button to stop showing this window. 
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Figure 2.8 The Undefined Objects list lets you see the undefined 
properties for each undefined object 

A. Define Reservoir J1 

 To define the first reservoir, open the J1 Reservoir Properties window 
(Figure 2.9) by double-clicking on the J1 icon. The pipe table should 
show you that Pipe 1 is connected to this reservoir (click the Pipe Depth 
& Loss Coefficients tab to display the pipe table). 
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Note: You can also open an object's Properties window by selecting the 
object (clicking on it) and then either pressing the Enter key or clicking 
the Open Pipe/Junction Window icon on the Workspace Toolbar. 

 Enter a Liquid Surface Pressure of 0 psig, Pipe Depth of 10 feet, and 
a Liquid Surface Elevation of 10 feet. This reservoir will represent the 
supply reservoir upstream of the pump. You can assign any unit of 
pressure or elevation found in the adjacent dropdown list of units. 

 

Figure 2.9 Properties window for Reservoir J1. You may or may 
not see additional tabs called Transient and Cost. 
These tabs are only visible if the XTS module is active 
or system costs are being calculated, respectively 

Note: You can choose default units for many parameters (such as feet 
for length) in the User Options window under Preferred Units. 



Chapter 2   Sizing a Pump Example   25 

You can give the component a name, if desired, by entering it in the 
Name field at the top of the window. In Figure 2.9, the name of this 
reservoir is Lower Reservoir. By default, the junction’s name indicates 
the junction type. The name can be displayed on the Workspace, Visual 
Report and in the Output. 

Most junction types can be entered into a custom database allowing the 
junction to be used multiple times or shared between users. To select a 
junction from the custom database, choose the desired junction from the 
Database List. The current junction will get the properties from the 
database component. 

The “Copy Data From Jct…”  list will show all the junctions of the same 
type in the model. This will copy the user-selected parameters from a 
specified existing junction in the model to the current junction. 

Using the folder tabs in the Properties windows 

The information in the Properties windows is grouped into several 
categories (or folders) and placed on separate tabs. Click the folder tab to 
bring its information forward. Figure 2.9 is an example of a reservoir’s 
Properties window. 

If there is only one pipe connected to the reservoir, the depth can be 
entered directly on the diagram on the Reservoir Model tab for 
convenience. The depth can also be entered no matter the number of 
pipes on the Pipe Depth & Loss Coefficients tab. The pipe table allows 
you to specify entrance and exit loss factors for each pipe connected to 
the tank (in this case there is only one). The default selection is for the 
loss factors to be specified as zero. To change the loss factors later, click 
within the pipe table and enter the loss. 

 Enter a pipe depth of 10 feet in the table.  

The Optional tab allows you to enter different types of optional data. 
You can select whether the junction number, name, or both are displayed 
on the Workspace. Some junction types also allow you to specify an 
initial pressure as well as other junction-specific data. 

Each junction has a folder tab for notes, allowing you to enter text 
describing the junction or documenting any assumptions. 

The highlight feature displays all the required information in the 
Properties window in light blue. The highlight is on by default. You can 
toggle the highlight off and on by double-clicking anywhere in the 
window above the folder tabs or by pressing the F2 key. The highlight 
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feature can also be turned on or off by selecting “Highlight in Pipe and 
Jct Windows” from the View menu. Note that the highlight feature is 
turned off in the Examples models. 

 Click OK. If “Show Object Status” is turned on, you should see the J1 
ID number turn black again, telling you that J1 is now completely 
defined. 

The Inspection feature 

You can check the input parameters for J1 quickly, in read-only fashion, 
by using the Inspection feature. Position the mouse pointer on the J1 
reservoir icon and hold down the right mouse button. The inspection 
window appears, as shown in Figure 2.10. 

Inspecting is a faster way of examining the input in an object than 
opening the Properties window. 

 

Figure 2.10 Inspecting from the Workspace with the right mouse 
button 

Inspection 
Window
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B. Define other junctions  

 Next, open the Properties window for Pump junction J2. Remember 
that the pump in this example is a centrifugal pump that is being sized. 
Select Centrifugal (Rotodynamic) and then Sizing for the Analysis Type. 
The Pump Sizing Parameter should be set to Volumetric Flow Rate. 
Enter the Fixed Flowrate as 500 gal/min, and the elevation as 0 feet (see 
Figure 2.11). 

 

Figure 2.11 Properties window for Pump J2  

 Open the J3 Reservoir junction and change the name to Upper 
Reservoir. Then enter a Liquid Surface Pressure of 0 psig, a Liquid 
Surface Elevation of 200 feet, and a pipe depth of 10 feet. 

 Save the model again before proceeding. 
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C. Define Pipe P1 

Data for pipes and junctions can be entered in any order. In this example, 
we did the junctions first. The next step is to define all the pipes. To open 
the Pipe Properties window, double-click the pipe object on the 
Workspace. 

 First, open the Pipe Properties window for Pipe P1 (see Figure 2.12). 
For Pipe P1, enter Steel - ANSI, 4 inch, STD (schedule 40), Standard 
friction model, and a length of 10 feet.  

 

Figure 2.12  Properties window for Pipe P1. You may or may not 
see an additional tab called Cost. This tab is only 
visible if the system costs are being calculated. 

The Pipe Properties window 

The Pipe Properties window offers control over all important hydraulic 
parameters that are related to pipes. 

The Inspect feature can be accessed not only from pipes and junctions 
located on the Workspace, but also from within the Properties window of 
each pipe (and certain junctions). This is helpful when you want to 
quickly check the properties of objects that connect to a pipe or junction 
whose Properties window you already have open.  
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To Inspect a junction connected to a given pipe, position the mouse 
pointer on the connected junction's ID number in that pipe’s Properties 
window (located at the top right of the Pipe Properties window) and hold 
down the right mouse button. This process can be repeated for any 
junctions that state the upstream and downstream pipe in the junction’s 
Properties window by holding the right mouse button on the pipe’s ID 
number. 

By double-clicking the connected junction number from a Pipe’s 
Properties window, you can jump directly to the Junction's Properties 
window. You can also click the Jump button to jump to any other part of 
your model. 

D. Define Pipe P2 

 Open the Properties window for Pipe P2 and specify Steel - ANSI, 4 
inch, STD (schedule 40), Standard friction model, and 990 feet in length. 
In addition, there are some elbows and fittings in this pipe. For 
simplicity, we are going to represent these as having a total K factor of 
25. This is entered on the Fittings & Losses tab in the Total K factor field 
(Figure 2.13).  

 

Figure 2.13 Values for losses on pipes due to fittings or other 
types of losses can be entered on the Fittings & 
Losses tab in the Pipe Properties Window 
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After completing Pipe P2, the Checklist should now be complete. 

E. Check pipes and junctions  

 Check if all the pipes and junctions are defined. If all data is entered, 
the “Define Pipes and Junctions” Checklist item on the Quick Access 
Panel will have a check mark. If not, turn on the “Show Object Status” 
from the View menu, and open each undefined pipe and junction. The 
Status tab on each Properties window will indicate what information is 
missing. 

F. Review Model Data 

 Before running the model, save it to file one more time. It is also a 
good idea to review the input using the Model Data window. 

Reviewing input in the Model Data window 

The Model Data window is shown in Figure 2.14. To change to this 
window, you can click on the Model Data tab, select it from the Window 
menu, or press CTRL-M. The Model Data window gives you a text-
based perspective of your model. Selections can be copied to the 
clipboard and transferred into other Windows programs, exported into 
Excel, saved to a formatted file, printed to an Adobe™ PDF, or printed 
out for review. 

Data is displayed in three general sections. The top is called the General 
Data section, the middle is the Pipe Data section and the bottom is the 
Junction Data section. Each section is collapsible using the buttons at the 
top left of the section. Further, each section can be resized. 

The Model Data window allows access to all Properties windows by 
double-clicking on any input parameter column in the row of the pipe or 
junction you want to access. You may want to try this right now. 
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Figure 2.14  The Model Data window shows all input in text form 

Step 5. Run the solver 

 Choose “Run Model” from the Analysis menu or click the arrow icon 
on the Main Toolbar. During execution, the Solution Progress window 
displays (see Figure 2.15). You can use this window to pause or cancel 
the Solver's activity. When the solution is complete, click the Output 
button and the text-based Output window will appear (see Figure 2.17). 
The information in the Output window can be reviewed visually, saved 
to file, exported to a spreadsheet-ready format, copied to the clipboard, 
printed to an Adobe PDF file, or printed out on the printer. 

General 
Data  
Section 

Junction 
Data  
Section 

Pipe 
Data 
Section 
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Figure 2.15  The Solution Progress window displays the 
convergence progress 

Step 6. Customize the output 

The Output Control window (Figure 2.16) allows you to select the 
specific output parameters you want in your output. You also can choose 
the units for the output.  

 Select Output Control from the Tools menu or the Main Toolbar to 
open the Output Control window. On the Display Parameters tab, select 
the Pipes button. The list of selected pipe output parameters will be 
displayed on the right-hand side. 

Click the General tab, enter a new title (if you like, you can title this 
“Water Transfer System”), then click OK to accept the title and other 
default data. 
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If you do not change any of the Output Control settings, default Output 
Control parameters and a default title are assigned. 

 

Figure 2.16 The Output Control window lets you customize the 
output 

Step 7. Review the output 

The Output window (Figure 2.17) is similar in structure to the Model 
Data window. Three areas are shown, and you can expand or collapse 
each area by dragging the boundary between the areas up or down or by 
clicking the arrow beside the area label. The items displayed in the tables 
are those items you chose in the Output Control window.  

Select the 
Output type 

These are the 
parameters  
that can be 
displayed 

Parameters  
can be viewed 
alphabetically 
or by category 

Description of 
terms can be 
displayed 

Reorder 
Output 

Shown in 
Output

Select 
units
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Figure 2.17 The Output window displays output in text form 

When pumps are included in a model, AFT Fathom gathers important 
pump data together in one convenient location in the Output window. 
This information can be found on the Pump Summary tab located in the 
General Output section of the output window, as shown in Figure 2.18. 

The Pump Summary shows that, for this system, the head requirement of 
the pump is 380.7 feet. The difference in elevation of the reservoirs is 
190 feet, hence this is the minimum required head rise regardless of the 
flow rate or pipe size. The friction loss is also approximately 190 feet. 
This can be seen in the dH column of the Pipe output window.   

General 
Output  
Section 

Junction 
Output  
Section 

Pipe  
Output  
Section 
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Figure 2.18 The Output window displays the Pump Summary tab 
whenever pumps are included in the system 

This Pump Summary can also be displayed in a Pump Results Diagram, 
as shown in Figure 2.19, by selecting the button next to “Show” in the 
Results Diagram column, double-clicking anywhere in the row, or right-
clicking anywhere in the row and selecting Pump Results Diagram. 

 

Figure 2.19 Pump Results Diagram as Opened from the Pump 
Summary (see Fig. 2.18) 
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A. Modify the output format 

If you selected the default AFT Fathom Output Control, the Pipe Results 
table will show volumetric flow rate in the second column with units of 
gal/min.  

 Select Output Control from the Tools menu or Main Toolbar to open 
the Output Control Window (see Figure 2.16). On the Display 
Parameters tab, select the Pipes button. The list of selected pipe output 
parameters will be displayed on the right-hand side. Change the units for 
Volumetric Flow Rate by selecting gal/hr (gallons per hour) from the 
unit list shown beside the parameter. 

 Click OK to display changes to the current results. You should see 
the volumetric flow rate results, still in the second column, in units of 
gal/hr. Notice the Velocity results in the third column. 

 Select Output Control from the Tools menu one more time. Select the 
Display Parameters tab and select the Pipe button. The Reorder scroll bar 
on the far right allows you to reorder parameters in the list. You can also 
click on the reorder symbol on the left side of each row to manually 
drag-and-drop the rows to change the parameter order (see Figure 2.16). 

 Select the Velocity parameter and use the Reorder scroll bar or drag-
and-drop to move it up to the top of the parameter list. 

 Click OK to display the changes to the current results. You will see 
in the Pipe Results table that the first column now contains Velocity, the 
second column now contains the Pipe Name, and the third column the 
Volumetric Flow Rate. The Output Control window allows you to obtain 
the parameters, units and order you prefer in your output. This flexibility 
will help you work with AFT Fathom in the way that is most meaningful 
to you, reducing the possibility of errors. 
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Figure 2.20 The Change Units window is opened from the Output 
window tables by double-clicking the column header 

 Select Output Control from the Tools menu once again. Select the 
Display Parameters tab and select the Pipes button. From the list on the 
left select Volumetric Flow Rate. Click the Add button to add it to the 
list on the right and change its units to gal/min. Then use the reorder 
button or row drag-and-drop to move it below the previous Volumetric 
Flow Rate item. 

 Click OK to display the changes to the current results. You will see 
two columns of Volumetric Flow Rate, each with different units. This is 
helpful when you want to see an output parameter in different sets of 
units simultaneously. 

 Lastly, double-click the column header for Velocity on the Output 
window Pipe Results Table. This will open a window in which you can 
change the units again if you prefer (see Figure 2.20). These changes are 
extended to the Output Control parameter data you have previously set. 

B. View the Visual Report 

The Visual Report allows you to show model input and output next to the 
model itself. Pipes can be colored based on ranges of output values (or 
simply one specific value) to aid in your understanding of the modeled 
system’s hydraulics. 
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 Change to the Visual Report window by clicking on the Visual Report 
tab, choosing it from the Window menu, or pressing CTRL-I. This 
window allows you to integrate your text results with the graphic layout 
of your pipe network. 

 

Figure 2.21 The Visual Report Control window selects content for 
the Visual Report window 

 Click the Visual Report Control button on the Visual Report 
Toolbar (or View menu) and open the Visual Report Control window, 
shown in Figure 2.21. Select Volumetric Flow Rate in the Pipe Results 
area and Pressure Static Inlet in the Junction Results area. Click the 
Show button. The Visual Report window graphic is generated (see 
Figure 2.22). 

It is common for the text in the Visual Report window to overlap when 
first generated. You can change this by selecting smaller fonts or by 
dragging the text to a new area to increase clarity.  You can also use the 
Visual Report Control window to display units in a legend to increase the 
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clarity of the display.  These adjustments have already been done in 
Figure 2.22. This window can be printed or copied to the clipboard for 
import into other Windows graphics programs, saved to a file, or printed 
to an Adobe PDF file. 

 

Figure 2.22 The Visual Report integrates results with model layout 

C. Graph the results 

 Change to the Graph Results window by clicking on the Graph Results 
tab or choosing it from the menu. The Graph Results window offers 
full-featured Windows plot preparation. 

AFT Fathom’s Graph Guide, accessed by clicking on the “What Would 
You Like to Do?” button located at the top right of the Graph area, 
provides assistance by guiding you through the creation of a “Quick and 
Simple” graph, or an “Advanced” graph (Figure 2.23). You can create a 
graph by following the prompts on the Graph Guide, by manually 
specifying the graphing parameters on the Graph Control tab on the 
Quick Access Panel, or from the “Select Graph Parameters” icon located 
in the top left corner of the Graph Results toolbar. For the remainder of 
this Quick Start Guide, the Graph Guide will be hidden, but keep in mind 
that you can use it whenever you would like assistance in creating a 
graph. 

Click here to 
open the Visual 
Report Control 

Click and drag 
text to preferred 
location 

Units may be 
displayed in a 
legend 
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Figure 2.24 shows the Graph Results window with the Graph Control tab 
enabled on the Quick Access Panel. 

 

Figure 2.23 The Graph Guide can be toggled on and off by 
clicking the “What Would You Like to Do?” button on 
the Graph Results window 

  

 

Figure 2.24 The Graph Results window and Quick Access Panel 
Graph Control tab is where various system parameters 
can be graphed 
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AFT Fathom gives you the ability to create “stacked graphs”. These are 
graphs that are displayed on top of each other with the same X-axis but 
with different parameters on the Y-axis. This feature is very helpful 
when you want to look the behavior of multiple hydraulic parameters in 
the same location of your model simultaneously without having to create 
completely separate graphs. 

In this example, you will create stacked graphs of the pressure and flow 
along the pipeline. 

 Click the Profile tab on the Quick Access Panel. In the Pipes selection 
list, click the All button to select all the pipes.  

 For the Length Units, select feet. 

 From the Parameters definition area, select “Pressure Static” and 
specify units of psig.  

 In order to add a stacked graph with the static pressure graph 
showing the volumetric flowrate along the pipeline, click the “Add” 
button, which is the green “+” icon next to “Select Parameter”. A new 
row under the Parameters definition area will appear.  

 Choose “Volumetric Flow Rate” in this new parameter row, and 
select units of gal/min. 

 Click the Generate button to create the stacked pressure and volumetric 
flow rate graphs. 

 To format the legend font size, right-click on each legend and use the 
scroll bar to decrease the font size to 9 for both graphs. Drag the static 
pressure graph legend to the upper right corner of the graph to improve 
visibility of the graphed data. 

 To format each axis font size, right-click on each axis title and use the 
scroll bar to decrease the size until the font size on each axis appears as 
you like. 

Figure 2.25 shows the input in the Parameters/Formatting area on the 
Quick Access Panel. 

Figure 2.26 shows the stacked graphs detailing the static pressure and 
volumetric flowrate along the entire pipeline modeled in this simple 
system. Note that the pump adds approximately 165 psig of pressure in 
order to maintain a flow of 500 gpm throughout the pipeline. 



42   AFT Fathom 10 Quick Start Guide 

 

Figure 2.25 The Graph Control tab on the Quick Access Panel 
allows you to specify the graph parameters you want 
to graph in the Parameters/Formatting area 

The graph colors, fonts and other elements can be modified using the 
Formatting area on the Graph Control tab on the Quick Access Panel. 
The Graph Results window can be printed, saved to file, copied to the 
clipboard, or printed to an Adobe PDF file. The graph’s x-y data can be 
exported to file or copied to the clipboard. 

 

The Add 
button adds 
another 
parameter to 
your graph 
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Figure 2.26 Graph Results window offers full-featured graphing. 
Here the static pressure and volumetric flow along the 
entire length of the pipeline is shown 

Step 8. Add a pump curve 

Now that the pump head requirement has been identified as 380.7 feet at 
the design flow rate of 500 gal/min, a pump of the correct size can be 
purchased to meet this requirement. Once the actual pump has been 
identified, the pump characteristics can be added to the pump component 
by adding the pump curve data to the pump junction. 

Open the Pump Properties window. Change the Analysis type from 
Sizing to Pump Curve. Then select the Enter Curve Data button. This 
will open the Pump Configuration window. 
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Data for the pump curve is entered in the Raw Data table. After the data 
has been entered, a curve fit for the data must be created by selecting the 
Generate Curve Fit Now button. Enter the following pump curve data, as 
shown in Figure 2.27. 

1. Flow Parameter: Volumetric (gal/min) 

2. Pressure/Head Parameter: Head (ft) 

3. Pump Curve Data: 

a. 400 ft @ 0 gal/min 

b. 381 ft @ 500 gal/min 

c. 250 ft @ 1000 gal/min 

4. Curve Fit Order:  2 

 

Figure 2.27 The Pump Configuration window is used to enter 
pump curve data 
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After the curve data is entered, click the Generate Curve Fit Now button 
and then the OK button. 

Note: This is a situation where a user could create a new scenario using 
the Scenario Manager to examine a “what-if” situation, without 
disturbing the basic model. See Chapter 4 for an example that illustrates 
how to use the Scenario Manager. 

Re-run this model. Examine the Pump Summary in the General Output 
Section. The output (Figure 2.28) shows the pump operating at a flow 
rate of 500.2 gal/min, and a head rise of 381 ft, which is acceptably close 
to the previous sizing calculation. 

Change to the Graph Results window, and choose Pump vs. System on 
the Graph Control tab on the Quick Access Panel (Figure 2.29). Here you 
can specify that a pump vs. system curve be created as shown in Figure 
2.30. 

 

Figure 2.28 Output when running with a pump curve 
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Figure 2.29 The Graph Control tab on the Quick Access Panel can 
be used to generate a Pump vs. System Curve 
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Figure 2.30 Pump vs. system curve using selected pump 

Conclusion 

You have now used AFT Fathom's five Primary Windows on a simple 
model to size and select a pump. 
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C H A P T E R  3  

Spray Discharge System Example 

The objective of this example is to find the minimum supply pressure 
needed to provide a system of eight spray discharge heads with at least 
100 gal/min to each spray head. 

Topics covered 

This example will cover the following topics: 

 Use of spray discharge junctions 

 Global Pipe Editing and Copy Junction Data From tool 

 Using manual iterative techniques to arrive at a desired result 

 Use of Isometric Pipe Drawing Mode 

Required knowledge 

This example assumes that the user has some familiarity with AFT 
Fathom, such as placing junctions, connecting pipes, and entering pipe 
and junction properties. Refer to the Sizing a Pump Example in Chapter 
2 for more information on these topics. 

Model file 

This example uses the following file, which is installed in the Examples 
folder as part of the AFT Fathom installation: 

 Spray Discharge.fth - AFT Fathom model file 
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Problem statement 

A spray discharge system consisting of eight spray discharge nozzles is 
supplied by a constant pressure supply. The system has one main supply 
line that branches into two supply lines that supply four sprays on each 
side. Determine the minimum supply pressure necessary to ensure a 
minimum volumetric flow rate of 100 gal/min through each of the spray 
junctions. 

Step 1. Start AFT Fathom 

From the Start Menu, choose AFT Products and AFT Fathom. 

Step 2. Specify system properties 

1. Open the System Properties window by selecting System Properties 
in the Analysis menu.  

2. On the Fluid Data tab, select the AFT Standard database and then 
select “Water at 1 atm” in the Fluids Available in Database list.  

3. Click “Add to Model” to select water for use in this model.  

4. Now type in 70 deg. F in the fluid temperature box and click 
“Calculate Properties”. This calculates the fluid properties to use in 
the model.  

5. Click OK. 

Step 3. Build the model 

A. Place the pipes and junctions 

At this point, the first two items are completed on the Checklist. The next 
Checklist item is to “Define Pipes and Junctions”. In the Workspace 
window, assemble the model as shown in Figure 3.1. 



Chapter 3   Spray Discharge System Example   51 

 

Figure 3.1 Layout of pipe system for Spray Discharge System 
Example 

B. Enter the pipe data 

The system is in place, but now you need to enter the input data for the 
pipes and junctions. Double-click pipe objects P1-P3 and enter the 
following data in the Properties window (pipes P4-P11 are addressed 
below using Global Editing). 
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Pipes P1-P11 are Steel - ANSI with standard roughness and the 
following data: 

Pipe Length 
(feet) 

Size Type 

P1 500 8 inch Schedule 40 

P2 500 8 inch Schedule 40 

P3 9 4 inch Schedule 40 

P4 10 1-1/2 inch Schedule 40 

P5 10 1-1/2 inch Schedule 40 

P6 10 1-1/2 inch Schedule 40 

P7 10 1-1/2 inch Schedule 40 

P8 10 1-1/2 inch Schedule 40 

P9 10 1-1/2 inch Schedule 40 

P10 10 1-1/2 inch Schedule 40 

P11 10 1-1/2 inch Schedule 40 

 

Because pipes P4-P11 are the same, you can use the Global Pipe Editing 
tool to speed up the process of entering the data. The Global Pipe Editing 
tool allows you to apply changes to multiple pipes at the same time. 
Select Global Pipe Edit from the Edit menu. This will open the Global 
Pipe Edit window. Select pipes P4-P11 from the list of pipes, as shown 
in Figure 3.2. 
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Figure 3.2 Global Pipe Edit window for Spray Discharge System 
Example 

After selecting the pipes, click the Select Pipe Data button. This will 
open a Pipe Properties window for entering the data that is to be applied 
to all of the selected pipes. Fill out the data for pipes P4-P11. When you 
have entered all of the data for the pipes, close the Pipe Properties 
window by selecting OK. The Global Pipe Edit window will now display 
a list of all of the parameters that may be applied to the selected pipes. 
The parameters are categorized as they are displayed on the tabs on the 
Pipe Properties window. For this example, you want all of the parameters 
for all of the selected pipes to be updated to the specified values. This 
can be accomplished by selecting the check box beside each parameter, 
or by selecting the All button above the list of parameters. The Global 
Pipe Edit window should now appear as shown in Figure 3.3. 
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Figure 3.3 Global Pipe Edit window for Spray Discharge System 
Example with all pipe parameters selected for updating 

Apply the changes to the selected pipes by clicking the Apply Selections 
button. AFT Fathom will notify you that the changes have been 
completed. Select OK. At this point, all of the changes have been 
applied. If you wish to cancel all of the changes you just implemented, 
you may do so by clicking Cancel on the Global Pipe Edit window. 
Accept the changes by clicking OK. 

C. Enter the spray data (J1-J8)  

Because all of the spray discharge junctions have the same input data, the 
Global Junction Edit tool could be used to input the data for all of the 
junctions at the same time. The Global Junction Edit tool works in much 
the same way as the Global Pipe Edit tool.  
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Another tool that can be used to speed up data entry for items with the 
same input data is the Copy Data From Junction tool. Enter the data for 
spray discharge junction J1, as listed below, by double-clicking the 
junction icon on the Workspace to open the Spray Discharge Properties 
window. 

1. Elevation = 10 feet 

2. Loss Model = Cd Spray (Discharge Coefficient) 

3. Geometry = Spray Nozzle 

4. Exit Pressure = 0 psig 

5. Cd (Discharge Coefficient) = 0.6 

6. Discharge Flow Area = 0.5 in2 

After the data has been entered for J1, and the Properties window has 
been closed, open the Properties window for spray discharge J2. Near the 
top of the Properties window is a drop-down box labeled Copy Data 
From Jct. This box lists all of the spray discharge junctions on the 
Workspace. Select junction J1 from the list. This will open the “Copy 
Data From Junction” window, which, similar to the Global Edit window, 
shows a list of all of the parameters for junction J1, and their values. By 
checking the box beside a parameter, the current junction will copy the 
parameter value from J1. In this case, you want all of the parameters for 
junction J2 to be the same as J1, so select the All button at the top of the 
list to select all of the parameters, as shown in Figure 3.4. 
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Figure 3.4 Copy Data from Junction window used for Copy Data 
from Junction tool 

After clicking the OK button in the Copy Data From Junction window, 
all of the junction J2 parameters are updated to the selected J1 parameter 
values. Repeat this process for all of the spray discharge junctions.  

There is a similar function available from the Pipe Properties window 
tool. 
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D. Enter other junction data 

J9 - Assigned Pressure  

1. Elevation = 1 feet 

2. Pressure = 200 psig, Stagnation 

J10 - Branch  

Elevation = 10 feet 

J11 - Branch  

Elevation = 1 feet 

J12 - Dead End  

Elevation = 1 feet 

E. Check if the pipe and junction data is complete 

Turn on “Show Object Status” from the View menu to verify that all the 
necessary data is entered. If all data is entered, the Define All Pipes and 
Junctions Checklist item on the Quick Access Panel will have a check 
mark. If not, the uncompleted pipes or junctions will have their number 
shown in red. If this happens, go back to the uncompleted pipes or 
junctions and enter the missing data. You can also open the List 
Undefined Objects window from the View menu to see what data is 
missing. 

Step 4. Run the model and iterate 

Select Run Model in the Analysis menu. This will launch the Solution 
Progress window. This window allows you to watch as the AFT Fathom 
Solver converges on the answer. When the solution has converged, view 
the results by pressing View Output at the bottom of the Solution 
Progress window. 

Open the Output Control window from the Tools menu. Add “Vol. Flow 
Rate Net at Junction” to the junction Output. 
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Figure 3.5  Output Window for Spray Discharge System Example 

The Output window contains all the data that was specified in the Output 
Control window. The output for the Spray Discharge example is shown 
in Figure 3.5, for a supply pressure of 200 psig, stagnation. The last 
column in the junction output table shows the volumetric flow rates for 
all of the spray discharge junctions are well above 100 gal/min required 
in the problem statement.  

Reduce the supply pressure and run the model again. Repeat this process 
until you have determined the minimum supply pressure required to 
supply 100 gal/min at every spray junction. 
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Step 5. Graph the results 

AFT Fathom allows you to create dual Y-axis graphs, which plot two 
parameters on the same graph. 

In this example, you will graph the static pressure and volumetric 
flowrate from the constant pressure supply J9 through spray nozzle J1 on 
a dual Y-axis graph to help you graphically determine whether the 
minimum flow through each spray nozzle is at least 100 gal/min.  

Note: You can repeat this process for the flow path from the constant 
pressure junction to spray nozzle J8, or you can graph both flow paths on 
this same graph using the Plot Multiple Paths Using Groups feature. 

1. From the Graph Control tab, choose the Profile tab in the 
Parameters/Formatting area, specify “Plot Single Path” in the Pipes 
definition area, then select pipes 1, 3, 4, 5, 6, and 7. These pipes 
make up the path from the constant pressure supply to the J1 spray 
nozzle. 

2. Ensure that “feet” is selected for the Length Units. 

You will need to decide what parameter you wish to plot on the primary 
Y-axis and which parameter you want to plot on the secondary Y-axis. In 
this example, we will plot static pressure on the primary Y-axis and 
volumetric flowrate on the secondary Y-axis. 

3. To do this, select “Pressure Static” in the Parameter definition area 
and choose “psig” as the static pressure unit. 

4. Add a parameter by clicking on the “Add” button next to “Select 
Parameter” in the Parameters definition area. 

5. Change this added parameter to “Volumetric Flowrate” and choose 
gal/min as the unit. 

6. To specify that the volumetric flowrate will be plotted on the 
secondary Y-axis, click the “Make Secondary Y-Axis” button, which 
is the blue, right arrow icon located at the top right over the selected 
parameters. Alternatively, you can double-click on the column in 
front of “Volumetric Flowrate” in the Parameter definition area. 
Note that “Volumetric Flowrate” becomes indented under “Pressure 
Static”, and that the black arrow next to “Volumetric Flowrate” turns 
to point towards the graph. See Figure 3.6 to see how these graphing 
parameters are defined. 
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Figure 3.6  Parameter definition for dual Y-axes graph of static 
pressure (Primary Y-axis) and volumetric flowrate 
(Secondary Y-axis) on the Graph Control tab on the 
Quick Access Panel 

Click the Generate button. You will see that the static pressure and 
volumetric flowrate drop, as expected, when some flow leaves the 
system through each spray nozzle. See the graph in Figure 3.7. 

Note that you can also plot the same parameter with different units on the 
secondary Y-axis. 
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Figure 3.7 Pressure and volumetric flowrate from the constant 
pressure supply (J9) to the spray nozzle at one end of 
the model (J1) 

Analysis summary 

The minimum required supply pressure necessary to supply a volumetric 
flow rate of 100 gal/min to all of the spray junctions is about 171 psig, 
stagnation. 

By iterating on values for the supply pressure, you were able to use AFT 
Fathom to determine the minimum required supply pressure for this 
system. This information can now be used to design the supply reservoir 
for this system. 

The goal seeking capabilities in the optional AFT Fathom GSC Module 
eliminate the manual iteration required for this problem. The supply 
pressure would be set as a variable, and the minimum flow rate of 100 
gal/min discharge for the spray discharges would be set as the goal (this 
is called a group max/min goal).  GSC would then modify the supply 
pressure until the goal was met, thus eliminating the need to run AFT 
Fathom multiple times to arrive at the final solution. 

More discussion on the GSC Module is given in Chapter 5. 
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Isometric Pipe Drawing Mode 

AFT Fathom allows the user to place pipe or junction objects anywhere 
in the Workspace. 

Objects are placed on a 2D grid by default, as was the case with this 
example. Figure 3.8 shows the spray discharge system with the 2D grid 
displayed (select Show Grid from the Arrange menu). 

 

Figure 3.8 Spray discharge system with 2D grid shown 

At times it may be convenient to demonstrate the three-dimensional 
nature of a system. For example, if you are building a model based on 
isometric reference drawings. AFT Fathom includes an Isometric Pipe 
Drawing Mode for these cases. The isometric grid has three gridlines that 
are offset by 60°, representing the x, y, and z axes. Figure 3.9 shows the 
spray discharge system built on an isometric grid. 
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Figure 3.9 Spray discharge system with the isometric grid shown 

You can enable the isometric grid in AFT Fathom by going to the 
Arrange menu. Under Pipe Drawing Mode, there are three options: 2D 
Freeform (default), 2D Orthogonal, and Isometric. 

Creating the spray discharge system on an isometric grid will 
demonstrate how to use this feature.  

1. Go to the File menu and select New. 
2. From the Arrange menu, Show Grid and choose Isometric under Pipe 

Drawing Mode. 
3. Place a Spray Discharge junction, J1, on the Workspace. You will 

notice that placing junctions onto the Workspace follows the usual 
rules, however, the visual appearance of the icon is more complex 
than in a 2D grid. Due to the increased number of axes, the preferred 
icon and rotation must be selected to obtain visual consistency. 
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4. Right click on J1 and select Customize Icon. Select the icon shown 
in Figure 3.10. 

 

Figure 3.10 Right click on the junction to open the Customize Icon 
window and select the preferred icon and rotation 

5. Copy J1 for the other spray discharges, J2-J8, to maintain the 
preferred icon and rotation. 

6. Place the assigned pressure junction, J9, on the Workspace. 
7. Place two branch junctions, J10 and J11, on the Workspace. 
8. Place the dead end junction, J12, on the Workspace. 
9. Right click on J12 and select Customize Icon. Notice that you may 

need to use the Rotate button to get the preferred icon and rotation, 
as shown in Figure 3.11. 
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Figure 3.11 Use the Rotate button to obtain the preferred icon and 
rotation 

10. Draw Pipes 1 and 2, as shown in Figure 3.9. 
11. Draw Pipe 3 from J11 to J10. A red-dashed preview line will show 

how the pipe will be drawn on the isometric grid. As you are 
drawing a pipe, you can change the preview line by clicking any 
arrow key on your keyboard or scrolling the scroll wheel on your 
mouse. Figure 3.12 shows Pipe 3 being drawn with the preview line. 

 

Figure 3.12 A preview line shows when drawing or adjusting 
pipes 



66   AFT Fathom 10 Quick Start Guide 

Note: You can hold the “Alt” key while adjusting a pipe by the endpoint 
to add an additional segment. This can be used with the arrow key or 
mouse scroll wheel to change between different preview line options.  

12. Draw Pipes 4-11, as shown in Figure 3.9. 
13. The grid can be shown or turned off in the Arrange menu.  

 

Figure 3.13 Isometric spray discharge system with the grid not 
shown 
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Freon Delivery System with Heat 
Transfer Example 

This example demonstrates how to use heat transfer modeling on pipes 
and heat exchangers. The example involves a review of the use of 
different refrigerant fluids to achieve certain design goals. 

Topics covered 

This example will cover the following topics: 

 Using the NIST REFPROP database to define fluids 

 Setting up a heat transfer model in System Properties 

 Specifying convective heat transfer data for pipes 

 Specifying thermal characteristics of heat exchangers 

 Entering pump curves 

 Entering resistance curves 

 Using Scenario Manager 

Required knowledge 

This example assumes that the user has some familiarity with AFT 
Fathom such as placing junctions, connecting pipes, and entering pipe 
and junction properties. Refer to Sizing a Pump Example in Chapter 2 
for more information on these topics. 
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Model file 

This example uses the following file, which is installed in the Examples 
folder as part of the AFT Fathom installation: 

 Freon System with HT.fth - AFT Fathom model file 

Problem statement 

This example will model a Freon delivery system that is to supply Freon 
at 75 deg. F. As the engineer, you will evaluate two candidate 
refrigerants (Refrigerant 11 and 123) to determine the best choice. You 
will also calculate the temperature of the hot water supply needed for the 
heat exchangers and select the refrigerant that requires the lowest water 
temperature. 

Step 1. Start AFT Fathom 

From the Start Menu choose AFT Products and AFT Fathom. 

Step 2. Specify system properties 

1. Open the System Properties window by selecting System Properties 
in the Analysis menu (see Figure 4.1).  

2. On the Fluid Data tab, select the NIST REFPROP database and then 
click Search and type “R11.” Select R11 in the Search Results. 

3. Click “Add to Model” to select R11 for use in this model. 

4. Now type in 150 in the fluid pressure box and -50 in the fluid 
temperature box. Select “psig” and "deg. F" for the units and click 
“Calculate Properties”. This calculates the default fluid properties to 
use in the model, although when modeling heat transfer AFT Fathom 
adjusts these properties during the simulation in accordance with 
calculated temperatures. 

5. Select the “Heat Transfer With Energy Balance (Single Fluid)” 
option. This enables AFT Fathom's heat transfer capabilities. 

6. Click OK. 
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Figure 4.1 System Properties window with R11 selected and the 
“Heat Transfer with Energy Balance (Single Fluid)” 
selected.  

Step 3. Build the model 

A. Place the pipes and junctions 

At this point, the first two items are completed on the Checklist. The next 
Checklist item is to “Define Pipes and Junctions”. In the Workspace 
window, assemble the model as shown in Figure 4.2. 
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Figure 4.2 Layout of pipe system for Freon Delivery System with 
Heat Transfer Example. Pipes 3-7 have graphical bends 
that can be added using the Pipe Segment tool on the 
Arrange menu. 

B. Enter the pipe data 

The system is in place, but now you need to enter the input data for the 
pipes and junctions. Double-click each pipe and enter the following data 
in the Properties window (or use the Global Pipe Edit window, as 
discussed in Chapter 3). 
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Pipes P1-P7 are Steel - ANSI with standard roughness and the following 
data: 

Pipe Length 
(feet) 

Size Type 

P1 10 3 inch Schedule 40 

P2 10 3 inch Schedule 40 

P3 5 3 inch Schedule 40 

P4 5 3 inch Schedule 40 

P5 5 3 inch Schedule 40 

P6 5 3 inch Schedule 40 

P7 30 3 inch Schedule 40 

 

Heat transfer data for piping is entered on the Heat Transfer tab on the 
Pipe Properties window. From the Heat Transfer tab, you first select the 
appropriate heat transfer model, then enter the required data for each 
type. For this example, you will be using the Convective Heat Transfer 
model. 

Enter the following data on the Heat Transfer tab for each pipe, as shown 
for P1 in Figure 4.3: 

1. Heat Transfer Model = Convective Heat Transfer 

2. Number of Insulation Layers = 1 External 

3. Ambient Temperature = 60 deg. F 

4. Use default values for Fluid Internal and Pipe Wall 

5. Insulation #1 (external) Data: 

a. Conductivity/Convection Data Source = User Specified 

b. Conductivity = 0.4 Btu/hr-ft-R 

c. Thickness = 1 inch 

6. External Data: 

a. Conductivity/Convection Data Source = User Specified 

b. Convection Coefficient = 10 Btu/hr-ft2-R 
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Figure 4.3  Pipe Heat Transfer tab for Freon Delivery System 
Example 

  

Figure 4.4 The Pipe Fittings & Losses Window is opened by 
clicking the Specify Fittings & Losses button on the 
Pipe Properties Window.  
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Note: This example uses a User Specified External Convection 
Coefficient. Alternatively, there are built-in Correlations available that 
will calculate free or forced convection coefficients for you. 

Pipes P3, P4, P5, and P6 have an additional loss due to an elbow fitting. 
The losses due to these fittings are added by clicking the Specify Fittings 
& Losses button on the Fittings & Losses tab on the Pipe Property 
window (Figure 4.4). This opens the Pipe Fittings & Losses Window. 
Note these could have been added as junctions and the fitting losses 
entered there. The two approaches yield the same results and are offered 
for user flexibility. 

For pipes P3-P6, open the Pipe Fittings & Losses Window, select the 
Bends tab, and enter a Quantity of 1 for a Standard Threaded, General, 
90 deg bend, and then click the OK button to add this loss to each pipe 
(Figure 4.5). Global pipe editing could also be used to make this change 
to all four pipes simultaneously. 

 

Figure 4.5 Fitting & Loss values are added to pipes by specifying 
fitting quantities on the Pipe Fittings & Losses Window. 
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C. Enter junction data  

J1 - Supply Reservoir  

1. Elevation = 10 ft 

2. Surface pressure = 150 psig 

3. Temperature = -50 F 

4. Pipe depth = 0 feet 

J7 - Receiving Reservoir 

1. Elevation = 10 ft 

2. Surface pressure = 150 psig 

3. Temperature = 75 F 

4. Pipe depth = 0 feet 

J3, J5 - Branch Junctions  

1. Elevation = 2 feet 

J2 - Pump Junction 

1. Elevation = 2 feet 

2. Pump Model = Pump Curve 

3. Enter the pump curve data (see Figure 4.6): 

a. Click the “Enter Curve Data” button 

b. On the Pump Configuration window, select the “Flow 
Parameter” as Volumetric, and the “Pressure Parameter” as 
Head.  

c. Enter the following pump curve data in the Raw Data table: 

Volumetric Flow Rate 

(gal/min) 

Head 

(feet) 

0 25 

200 24 

500 15 
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d. Select “Generate Curve Fit Now” to create the curve fit. 

e. Close the Pump Configuration window by clicking OK. 

 

Figure 4.6  Pump Configuration Window for the Freon Delivery 
System Example 

J4, J6 - Heat Exchangers 

1. Elevation = 2 feet 

2. Loss Model = Resistance Curve 

3. Enter resistance curve data (see Figure 4.7): 

a. Click the “Enter Curve Data” button 

b. Select the “Flow Parameter” as Volumetric 

c. Enter 250 gpm and 2 psid in the Raw Data table 
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d. Click the “Fill as Quadratic” button to create data for a “square 
law” loss curve, which is typical of heat exchangers and other 
components. 

e. Select “Generate Curve Fit Now” to create a quadratic curve fit 

f. Close the Heat Exchanger Loss Curve Fit window by clicking 
OK. 

4. Enter the following data on the Thermal Data tab: 

a. Thermal Model = Counter-Flow 

b. Heat Transfer Area = 80 feet2 

c. Overall Heat Transfer Coefficient = 500 Btu/hr-ft2-R 

d. Secondary Fluid Flow Rate = 30 lbm/sec 

e. Secondary Fluid Specific Heat = 1 Btu/lbm-R 

f. Secondary Fluid Inlet Temperature = 200 deg. F 

 

Figure 4.7  Heat Exchanger Loss Curve Fit Window for the Freon 
Delivery System Example 
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To solve this problem, you will have to guess the inlet temperature of the 
secondary fluid (hot water) for both heat exchangers. Start with 200 deg. 
F. You will then have to run the model, examine the results, and adjust 
the secondary fluid inlet temperature until you achieve the desired Freon 
outlet temperature of 75 deg. F.  

D. Check if the pipe and junction data is complete 

Turn on “Show Object Status” from the View menu to verify that all the 
necessary data is entered. If so, the “Define Pipes and Junctions” 
Checklist item on the Quick Access Panel will have a check mark. If not, 
the uncompleted pipes or junctions will have their number shown in red. 
If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data. You can also open the List Undefined Objects window 
from the View menu to see what data is missing. 

Step 4. Create a scenario for each refrigerant 

For this problem, you are required to determine which refrigerant is the 
best one for this application by minimizing the temperature of the hot 
water used to heat the Freon to the delivery temperature. To do this, you 
will use the Scenario Manager to examine the different results for each 
refrigerant in the system.  

The Scenario Manager is a powerful tool for managing variations of a 
model, referred to as scenarios. The Scenario Manager allows you to: 

 Create, name and organize scenarios 

 Select the scenario to appear in the Workspace (the ‘current’ 
scenario) 

 Delete, copy and rename scenarios 

 Duplicate scenarios and save them as separate models 

 Review the source of a scenario’s properties 

 Pass changes from a scenario to its variants 

You will create two scenarios to model these cases. Scenarios are created 
using the Scenario Manager. The Scenario Manager can be accessed 
from the Tools menu, or from the Quick Access Panel which is located 
on the right side of the Workspace area.  
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Click the "Create Child" button in the Scenario Manager on the Quick 
Access Panel. Name the child “R11”. A new scenario will appear below 
the Base Scenario in the list shown in the Scenario Panel. Select the Base 
Scenario, create another child, and call it “R123”. See Figure 4.8.  

 

Figure 4.8 The Scenario Manager on the Quick Access Panel 
allows you to create model variants and keep them 
organized within the same model file 
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Step 5. Set up the R11 case 

The base scenario contains all of the basic information for the model, 
such as the pipe and junction layout, pipe lengths, system properties etc. 
Now you must modify the system conditions for each scenario to use the 
refrigerant that will be analyzed for that case. 

Child scenarios “inherit” data from their ancestors. As long as the data 
has not been modified in a child scenario, data parameters in the child 
scenario will have the same value as their parent. In this example, you 
entered R11 as the fluid in the System Properties window in the Base 
Scenario, so the R11 scenario has inherited the same fluid properties as 
the Base Scenario. Therefore, no changes need to be made to the R11 
scenario. 

Double-click the “R11” scenario in the list in the Scenario Manager on 
the Quick Access Panel. This will load the R11 scenario into the 
Workspace as the current scenario. The currently loaded scenario is 
displayed in the list with a green check mark (Figure 4.8). 

Step 6. Run the R11 case 

Starting with the initial guess of 200 deg. F for the Secondary Fluid 
Temperature, select Run Model in the Analysis menu. This will launch 
the Solution Progress window. This window allows you to watch as the 
AFT Fathom Solver converges on the answer. Once the model has 
converged, you can view the results by pressing View Output at the 
bottom of the Solution Progress window. 

Step 7. Examine the R11 results 

The Output window contains all the data that was specified in the Output 
Control window.  

Examination of the R11 delivery temperature at the outlet of pipe P7 
shows a temperature of 115 deg. F (see Figure 4.9, also visible with 
additional detail in Figure 4.10 and 4.11). This is well above the required 
minimum delivery temperature of 75 deg. F. The inlet temperature of the 
Secondary Fluid must be decreased, and the model must be run again to 
determine the outlet temperature at the new value. This process must be 
repeated until the Secondary Fluid Inlet Temperature that delivers the 
Freon at 75 deg. F is determined. 
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Figure 4.9  Output for Freon Delivery System for R11 with a 
Secondary Fluid Inlet Temperature of 200 deg. F 
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Figure 4.10  Heat Transfer tab in Output window shows detailed 
heat transfer results for pipes 

The pipe heat transfer results from the Heat Transfer tab (see Figure 
4.10) can also be displayed in a Results Diagram, as shown in Figure 
4.11, by selecting the button next to Show in the Results Diagram 
column, double-clicking anywhere in the row, or right-clicking anywhere 
in the row and selecting Results Diagram. 

 

Figure 4.11  Pipe Heat Transfer Results Diagram Opened from the 
Heat Transfer Table (see Fig. 4.10) 
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Step 8. Set up the R123 case 

Double-click the R123 scenario in the list in the Scenario Manager on the 
Quick Access Panel to load it as the current scenario. 

Open the System Properties window from the Analysis menu and select 
R123 similar to Step 2. 

Step 9. Run the R123 case 

Starting with the initial guess of 200 deg. F for the Secondary Fluid 
Temperature, select Run Model in the Analysis menu. This will open the 
Solution Progress window. This window allows you to watch as the AFT 
Fathom Solver converges on the answer. Once the model has converged, 
you can view the results by pressing View Output at the bottom of the 
Solution Progress window. 

Step 10. Examine the R123 results 

The Output window contains all the data that was specified in the Output 
Control window.  

Examination of the R123 delivery temperature at the outlet of pipe P7 
shows a temperature of 102 deg. F (see Figure 4.11).  This is well above 
the required minimum delivery temperature of 75 deg. F. The inlet 
temperature of the Secondary Fluid must be decreased, and the model 
must be run again to determine the outlet temperature at the new value. 
This process must be repeated until the Secondary Fluid Inlet 
Temperature that delivers the Freon at 75 deg. F is determined. 
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Figure 4.11  Output for Freon Delivery System for R123 with a 
Secondary Fluid Inlet Temperature of 200 deg. F 
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Analysis summary 

The results of the iterative solutions show the following: 

Refrigerant Secondary Fluid Inlet Temp 

(deg F) 

R11 138.5 

R123 154.6 

 

In terms of heat exchanger hot water temperature, R11 is the better 
choice for a refrigerant delivery temperature of 75 deg. F. However, 
there may be other factors, such as environmental regulations, that must 
be considered in the selection of a refrigerant. 

Similar to the spray system in Chapter 3, this example requires manual 
iteration to obtain the results. The goal seeking capabilities in the 
optional AFT Fathom GSC Module would allow this problem to be 
solved directly without manual iteration. The variables would be 
specified as the heat exchanger secondary inlet temperature (these 
variables would be linked), and the goal would be the pipe exit 
temperature. 

More discussion on the GSC Module is given in Chapter 5. 
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AFT Fathom Add-on Modules Examples 

This chapter covers two examples. This first example demonstrates how 
to use the Goal Seek and Control (GSC) and Extended Time Simulation 
(XTS) optional add-on modules to AFT Fathom. Later in the chapter, a 
second example using the Settling Slurry (SSL) module will be covered. 

The Automated Pipeline Sizing (APS) and Automated Network Sizing 
(ANS) modules are covered in a separate Quick Start Guide. 

The user can only perform these examples if access to the relevant 
module is available. 

Topics covered 

These examples will cover the following topics: 

 Goal Seek and Control Manager 

 Defining GSC Variables and Goals 

 XTS Transient Control 

 Defining system transients 

 Defining settling slurry properties 

Required knowledge 

This example assumes that the user has some familiarity with AFT 
Fathom such as placing junctions, connecting pipes, and entering pipe 
and junction properties. Refer to Sizing a Pump Example in Chapter 2 
for more information on these topics. To model the heat transfer in the 
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GSC example, the user may need to refer to Chapter 4 for more detailed 
explanations on modeling heat transfer. 

Model files 

These examples use the following files, which are installed in the 
Examples folder as part of the AFT Fathom installation: 

 Controlled HX Temperature.fth - AFT Fathom model file (GSC and 
XTS Examples) 

 Pump Sizing for Sand Transfer System - SSL.fth - AFT Fathom 
model file (SSL Example) 

Problem statements 

GSC Example 

A heat exchanger system has a bypass line that is used to divert flow 
around the heat exchangers. This is sometimes necessary to maintain a 
constant downstream temperature of 120 deg. F. Use the GSC module to 
determine the valve open percentage required to maintain the proper 
delivery temperature for a supply temperature of 200 deg. F. 

XTS Example 

The discharge reservoir is a finite sized tank, 20 feet high, with a cross 
sectional area of 80 ft2. The pump is to shut off when the tank is filled. 
How long does it take to fill the tank? What happens after the pump is 
turned off? 

SSL Example 

Use the settling slurry module to size a slurry pump. The system will 
pump 25% sand by volume from an open supply vessel with a liquid 
surface elevation of 5 feet to an open receiving tank. 

Step 1. Start AFT Fathom 

From the Start Menu choose AFT Products and AFT Fathom. 



Chapter 5   AFT Fathom Add-on Modules Examples   87 

Step 2. Specify system properties 

1. Open the System Properties window by selecting System Properties 
in the Analysis menu 

2. On the Fluid Data tab, select the AFT Standard database and then 
select “Water at 1 atm” in the Fluids Available in Database list 

3. Click “Add to Model” to select water for use in this model 

4. Type in 70 in the fluid temperature box and specify the units as 
“degrees F” 

5. Click “Calculate Properties” 

6. Select “Heat Transfer With Energy Balance (Single Fluid)” 

7. Select OK 

Step 3. Build the model 

A. Place the pipes and junctions 

At this point, the first two items are completed on the Checklist. The next 
Checklist item is to “Define Pipes and Junctions”. In the Workspace 
window, assemble the model as shown in Figure 5.1. 

B. Enter the pipe data 

The system is in place, but now you need to enter the input data for the 
pipes and junctions. Double-click each pipe and enter the following data 
in the Properties window (or use the Global Pipe Editing window, as 
discussed in Chapter 3). 
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Pipes P1-P10 are Steel - ANSI with standard roughness and the 
following data: 

Pipe Length 
(feet) 

Size Type 

P1 20 8 inch Schedule 40 

P2 5 8 inch Schedule 40 

P3 20 8 inch Schedule 40 

P4 20 8 inch Schedule 40 

P5 20 8 inch Schedule 40 

P6 20 8 inch Schedule 40 

P7 20 8 inch Schedule 40 

P8 20 8 inch Schedule 40 

P9 200 8 inch Schedule 40 

P10 100 8 inch Schedule 40 

 

All of the pipes are very well insulated, so select the Adiabatic option on 
the Heat Transfer tab. 

C. Enter the junction data 

J1, J9 - Reservoirs 

1. Tank Model = Infinite Reservoir (only visible if XTS module is 
enabled) 

2. Liquid Surface Pressure = 40 psig 

3. Liquid Surface Elevation = 10 feet 

4. Liquid Temperature = 200 F 

5. Update Density On Temperature Changes = Checked (the Liquid 
Density will be calculated automatically to 60.10897 lbm/ft3) 

6. Pipe Depth = 0 feet 
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Figure 5.1 Layout of pipe system for Controlled Heat Exchanger 
Temperature Example 

J2 - Pump  

1. Elevation = 0 feet 

2. Type = Pump Curve 

3. Pump Curve Data: 

Q (gal/min) dH (feet)

0 70 

500 60 

1000 40 
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J3 - Three-Way Valve  

1. Elevation = 0 feet 

2. Combined Flow Pipe = P2 

3. Split Flow Pipe #1 = P3 

4. Split Flow Pipe #2 = P9 

5. Valve Cv Data (ignore area data): 

Open Pct. Cv Pipe #1 Cv Pipe #2 

0 0 100 

100 100 0 

6. Actual Percent Open = 75% 

J4, J7, J8 - Branch Junctions  

Elevation = 0 feet 

J5, J6 - Heat Exchangers  

1. Elevation = 0 feet 

2. Loss Model = K Factor (Constant) 

3. K = 1400 

4. Thermal Model = Counter-Flow 

5. Heat Transfer Area = 1600 ft2 

6. Overall Heat Transfer Coefficient = 50 Btu/hr-ft2-R 

7. Secondary Fluid Flow Rate = 200 lbm/sec 

8. Secondary Fluid Specific Heat = 1 Btu/lbm-R 

9. Secondary Fluid Inlet Temperature = 40 F 

D. Check if the pipe and junction data is complete 

Turn on “Show Object Status” from the View menu to verify that all the 
necessary data is entered. If so, the “Define Pipes and Junctions” 
Checklist item on the Quick Access Panel will have a check mark. If not, 
the uncompleted pipes or junctions will have their number shown in red. 
If this happens, go back to the uncompleted pipes or junctions and enter 
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the missing data. You can also open the List Undefined Objects window 
from the View menu to see what data is missing. 

GSC problem statement 

Use the Goal Seek and Control module to determine the valve open 
percentage required to maintain a 120 deg. F temperature at branch 
junction J9 for a reservoir supply temperature of 200 deg. F. 

GSC Step 1. Create a scenario for GSC case 

Create a new scenario from the Base Scenario for the GSC Case. Refer to 
Chapter 4 for directions on how to add a scenario. 

GSC Step 2. Activate the GSC Module 

Activate the GSC Module by choosing Activate Modules from the Tools 
menu and selecting the GSC Module in the list.  

GSC Step 3. Open the Goal Seek and Control Manager 

When the GSC Module is activated, Specify Goal Seek and Control 
appears as an additional Checklist item. 

The Goal Seek and Control is specified by entering data for variables and 
goals in the Goal Seek and Control Manager window. Open the Goal 
Seek and Control Manager from the Analysis Menu. After opening the 
Goal Seek and Control Manager, the user specifies all of the system 
variables, as well as the desired goals. The Goal Seek and Control 
Manager is shown in Figure 5.2 below. 
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Figure 5.2 The Goal Seek and Control Manager is used to define 
GSC Variables and Goals 

GSC Step 4. Add a variable 

In the GSC module, variables are the parameters that AFT Fathom will 
modify in order to achieve the specified goals. To obtain a unique answer 
there should be one variable applied for each goal. You may define as 
many variables and goals as you wish. 

Select the Variables tab on the Goal Seek and Control Manager window. 
The Variables tab allows users to create and modify the system variables. 
On the Variables tab, you are able to select the object and junction types, 
the name and number of the object to which the variable applies, and the 
object parameter that is to be varied. Additionally, you can elect to apply 
certain variables while omitting others.  

 

 



Chapter 5   AFT Fathom Add-on Modules Examples   93 

For this example, you will be adding a variable for the Three-Way Valve 
Percent Open. Select the “New Variable” button, and input the following 
variable data: 

1. Apply: Selected 

2. Object Type: Junction  

3. Junction Type: Three-Way Valve 

4. Junction Number and Name: J3 (Three-Way Valve) 

5. Variable Parameter: Open Percentage  

6. Link To: (None) 

7. Lower and Upper Bounds: Use defaults provided 

The Apply column allows users to specify which of the variables that 
have been defined will be used. This allows the flexibility of creating 
multiple variable cases, while only applying selected variables for any 
given run. 

The Link To column allows users to apply the same variable to multiple 
objects. This allows users to force parameters for several objects to be 
varied identically. 

Upper and lower bounds provide logical extremes during the goal search. 
For this case, leave the lower bound as 0 %, and the upper bound as  
100 %. 

After entering the data, the Variable tab should appear as shown in 
Figure 5.3. 

GSC Step 5. Add a goal 

Goals are the parameters you want to achieve. The goals are achieved as 
AFT Fathom modifies the variables. To obtain a unique answer there 
should be one goal applied for each variable. You may define as many 
variables and goals as you wish. 

Select the Goals tab on the Goal Seek and Control Manager window. The 
Goals tab allows users to create and modify the system goals. The goal 
type, object type, and the goal parameter are selected. A criterion for 
determining if the goal has been met is then specified, along with a value 
and units for the goal parameter. The user then selects the object to 
which the goal applies, and, if applicable, the location on the object at 
which the goal applies (e.g., the inlet or outlet of a pipe object). 
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Figure 5.3 GSC Variables are parameters that are changed by AFT 
Fathom to achieve the defined goals 

Create a new goal for the downstream temperature as defined below: 

1. Apply:  Selected 

2. Goal Type:  Point   

3. Object Type: Branch 

4. Goal Parameter:  Temperature 

5. Criteria:  =  

6. Goal Value:  120 

7. Goal Units:  deg. F 

8. Object ID:  J8 (Branch) 

9. Object Location:  Outlet 

After entering the data, the Goals tab should appear as shown in Figure 
5.4. 
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Figure 5.4 GSC Goals are the parameter values set by the user that 
AFT Fathom adjusts the variables to achieve 

As variables and goals are added to a model, AFT Fathom will display 
symbols beside the pipes and junctions that have variables or goals 
applied to them. The default is a “V” for variables, and a “G” for goals. 
This is illustrated in Figure 5.5. 

 

Note: The goal symbol is not displayed next to objects that are part of a 
group goal. 
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Figure 5.5 AFT Fathom displays symbols next to objects on the 
Workspace that have goals or variables defined 

GSC Step 6. Activate GSC analysis 

After the GSC goals and variables have been defined, GSC must be 
enabled using the Analysis menu, as shown in Figure 5.6. 

GSC Step 7. Run the model 

Select Run Model in the Analysis menu. This will open the Solution 
Progress window. This window allows you to watch as the AFT Fathom 
Solver converges on the answer.  

“V” Symbol 
for a GSC 
Variable 

“G” Symbol 
for a GSC 
Goal 
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Figure 5.6  Select “Use” from the Goal Seek & Control menu item 
on the Analysis menu to instruct AFT Fathom to use 
goal seeking when it runs 

Note: When using the GSC module, there is a new area displayed in 
Solution Progress that shows the specific progress of the GSC module. 
As it makes progress, the Best (Lowest) value will decrease towards 
zero. The field in the far right displays how many complete hydraulic 
solutions have been run. 

After completion, click the View Output button at the bottom of the 
Solution Progress window. 
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GSC Step 8. Examine the results 

The Output window contains all the data that was specified in the output 
control window. The results of the GSC analysis are shown in the 
General Output section.  

The GSC Variables tab shows the final values for the variable 
parameters, as shown in Figure 5.7. The GSC Goals tab shows the values 
achieved for the goals, as shown in Figure 5.8. 

 

Figure 5.7  The final GSC Variable values are shown on the GSC 
Variables tab in the Output window General section 

 

Figure 5.8  The final GSC Goal values are shown on the GSC Goals 
tab in the Output window General section. The Actual 
and User values should be close if GSC was succesful. 
If not, a warning will appear 

GSC analysis summary 

For this example, the goal of 120 F was achieved for the temperature at 
branch junction J8 as shown in Figure 5.8. The open percentage required 
for the Three-Way Valve to achieve a temperature of 120 F at Branch J9 
is 85.87%, as shown in Figure 5.7. 
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XTS problem statement 

Use the Extended Time Simulation module to determine the length of 
time required to fill the discharge reservoir, and to turn off the pump 
when the tank is full. 

The discharge reservoir is a finite sized tank, 20 feet high, with a cross 
sectional area of 80 ft2. The pump is to shut off when the tank is filled. 
How long does it take to fill the tank? What happens after the pump is 
turned off? 

XTS Step 1. Create a scenario for XTS case 

Create a new scenario from the Base Scenario for the XTS Case. Refer to 
Chapter 4 for directions on how to add a scenario. 

XTS Step 2. Activate the XTS Module 

Activate the XTS Module by choosing Activate Modules from the Tools 
menu and selecting the XTS Module in the list.  

When the XTS Module is activated, Specify Transient Control appears as 
an additional Checklist item. 

Important: The XTS and GSC modules can be used in the same run to 
simulate control functions over time, but we are not going to do this here. 
Before proceeding, disable the GSC parameters by selecting Goal Seek 
& Control from the Analysis menu and then Ignore. 

XTS Step 3. Modify the existing model 

A. Enter the new junction and system data 

When using XTS, reservoirs may be defined as finite sized tanks. Modify 
reservoir J9 to be a finite tank with the following data: 

J9 - Reservoir 

1. Name = Discharge Reservoir 

2. Tank Model = Finite Open Tank 

3. Known Parameters Initially = Liquid Surface Level, Surface Pressure 
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4. Cross-Sectional Area = Constant, 80 ft2 

5. Liquid Height = Height from Bottom, 0 feet 

6. Liquid Surface Pressure = 40 psig 

7. Tank Height = 20 feet 

8. Pipe Elevation = 10 feet 

9. Tank Bottom Elevation = 10 feet 

J3 - Three-Way Valve  

1. Actual Percent Open = 86 % 

Heat transfer cannot be calculated when using XTS. Open the System 
Properties window and select “Constant Fluid Properties” to turn off the 
heat transfer option. If heat transfer is active when you try to run an XTS 
model, AFT Fathom will notify you that heat transfer calculations cannot 
be made. You will then be given the option of continuing the run without 
heat transfer or stopping the run altogether. 

B. Check if the pipe and junction data is complete 

Turn on “Show Object Status” from the View menu to verify that all the 
necessary data is entered. If so, the “Define Pipes and Junctions” 
Checklist item on the Quick Access Panel will have a check mark. If not, 
the uncompleted pipes or junctions will have their number shown in red. 
If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data. You can also open the List Undefined Objects window 
from the View menu to see what data is missing. 

XTS Step 4. Specify transient output time format  

The format and units used to display the transient data in the Output 
window are controlled from the Format & Action tab on the Output 
Control window. Open the Output Control window from the Tools Menu 
and select the Format & Action tab. Set the Time Simulation Formatting 
units to minutes, and then select OK to close the window. 

XTS Step 5. Activate transient analysis 

The XTS module may be turned on and off so users can run steady-state 
models using AFT Fathom. It is often useful to check the model steady-
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state solutions before attempting to run a transient case to ensure the 
model is realistic.  

In order to run a transient analysis using XTS, the analysis must first be 
set to Transient. This is done by selecting Time Simulation from the 
Analysis Menu, as shown in Figure 5.9. 

 

Figure 5.9  Transient Analyses are activated from the Analysis 
menu. 

XTS Step 6. Open transient control 

XTS module transient simulations are controlled through the Transient 
Control window. Activate the Transient Control window by selecting 
Transient Control from the Analysis Menu, or by clicking the Model 
Status light and selecting Transient Control from the list. Transient 
Control will not appear in the list if AFT Fathom is set to perform 
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steady-state analyses. When AFT Fathom is set to perform a transient 
analysis, the Transient Control becomes a new Checklist item required to 
run the model. 

The Transient Control window is used to specify transient start and stop 
times, as well as the time step controls and solution parameters for finite 
tank liquid level calculations. Start times, stop times, and time steps can 
be specified in any units from seconds to years. From the Transient 
Control window, users can specify the number of output points that are 
saved to the transient output file. This allows XTS to do transient 
calculations with a small time step while limiting the size of the transient 
data output file. 

For this example, the simulation will run for 45 minutes, with a time step 
of 1 minute. The output will be saved to the output file for every time 
step. The Transient Control window should appear as shown in Figure 
5.10. 

 

Figure 5.10  The Transient Control window is used to specify 
transient run times and time step sizes 
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XTS Step 7. Set up the pump transient 

In the XTS module, transients can be defined for junctions. These 
transients include valves opening and closing, and pumps starting and 
tripping. Transients for junctions can be defined as either time based or 
event based transients. A time based transient starts at a specified 
absolute time. Event based transients are initiated when a defined 
criteria, such as a pressure in a particular pipe is reached or exceeded. 
There are three types of event transients for junctions. Single event 
transients are events that occur only once in a simulation. Dual cyclic 
events are two transient events that repeat one after the other as many 
times as the event triggers occur during a simulation (such as a valve 
closing then reopening). Dual sequential transient events are two 
transient events which occur one after the other, without repeating. 

For this example, we will set an event-based transient on the pump so the 
pump will turn off when the liquid level in the discharge tank reaches 20 
feet. 

You will define a single transient event. The event will occur when the 
liquid height in the reservoir reaches 20 feet. When the liquid height 
reaches 20 feet, the pump speed will drop from 100% to 0% in 10 
seconds. 
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Figure 5.11  Junction transients are specified on the Transient tabs 
on the junction Properties windows 

Open the Pump Properties window, and select the Transient Data tab.  
Then select Single Event for the Initiation of Transient. Enter the 
Transient data as shown in Figure 5.11. 

XTS Step 8. Run the model 

After all of the pipes and junctions have been defined, and all of the 
transient data and transient control items have been specified, the 
transient simulation may be executed. Select Run Model in the Analysis 
menu. This will open the Solution Progress window. This window allows 
you to watch as the AFT Fathom Solver converges on the answer.  

When using the XTS module, the Solution Progress window displays the 
progress through the transient analysis. This information is displayed 
below the solution tolerance data, as shown in Figure 5.12. 
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Figure 5.12  The Solution Progress window shows the progress of 
the transient analysis 

After the run has completed, the results can be reviewed by clicking the 
View Output button. 

XTS Step 9. Examine the transient results 

The first thing that you may notice after clicking the View Output button 
is that “Critical Warnings Exist,” as shown in Figure 5.13. For this 
scenario, there is a critical warning because “Junction 2 Had Reverse 
Flow – Pump Head Could Not Be Predicted (33 minutes).”  

A critical warning is very important and should be reviewed. By 
examining the transient results of this scenario, you can understand why 
this warning occurs and how it affects the model. 
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Figure 5.13  A Critical Warning Exists because there is reverse 
flow through the pump. The warnings and transient 
results need review. 

To begin examining the transient results, it is important to understand 
that the AFT Fathom XTS module displays transient output in a number 
of places in the Output window.  

Each of the summary tables in the General Output section has a 
companion transient summary tab which displays the summary data at 
each time step in the transient run. Each junction included in the 
summary is included in the transient summary. The transient summary 
data for each junction may be expanded or collapsed by clicking the + or 
– sign beside the junction data list. The entire list may be expanded or 
collapsed by clicking the button in the top left-hand corner of the 
transient summary window. Figure 5.14 shows the Reservoir Transient 
summary tab, with the data for Reservoir J1 collapsed, and Reservoir J9 
expanded.  



Chapter 5   AFT Fathom Add-on Modules Examples   107 

The Quick Graph feature can be used to conveniently plot transient data 
for quick examination. To use the Quick Graph feature, place the mouse 
cursor over the column of transient data you wish to examine. Then, right 
click with the mouse, and select Quick Graph from the list of options. 
Figure 5.14 illustrates how to do this for J9 Reservoir Liquid Height vs. 
Time. Figure 5.15 shows the resulting graph. The graph illustrates how 
the liquid level in the Reservoir rises with time, as would be expected. 
The Graph Results window may also be used to create a full range of 
graphs related to the XTS transient output. 

 

Figure 5.14  The Quick Graph feature can be accessed from any 
transient data column using the right mouse button. 
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Figure 5.15  The Quick Graph feature can be used to quickly plot 
transient data from the Output for review.  

Consider Figure 5.15 in terms of the Critical Warning, which states that 
pump head could not be predicted at 33 minutes due to reverse flow 
through the pump. The tank liquid height increases until the time when 
the pump turns off. The graph then shows that there is back flow into the 
system, which causes the Critical Warning. This is discussed further in 
the XTS Analysis Summary after further examination of the transient 
results. 

Similar to the transient summary data, the transient tabs in the Pipe and 
Junctions sections of the Output Window are used to display the transient 
data for each pipe and junction at every time step, as shown in Figure 
5.16. This transient data can be expanded or collapsed in the same 
manner as in the General Output transient summaries. 

Figure 5.17 shows the transient output data for the pipes and junctions, 
found on the Pipes and All Junctions tabs at Time = 5 minutes. The 
output for all of the pipes and junctions can be displayed at any time step 
by using the slider bar located at the bottom of the Output window.  
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Figure 5.16  The Transient tabs in the Pipe and Junction sections 
show results for all time steps. The first number in the 
left column is the pipe/junction number and the 
second (in parentheses) is the time (in minutes) 
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Figure 5.17 The Pipe and Junction output can be displayed at any 
time step using the slider bar at the bottom of the 
output window 

When junction event transients occur, these events are recorded and 
displayed in the general output section of the Output Window. The 
events are displayed on two different tabs. The first tab sorts the events 
by junction number, and the second tab sorts the events by time, in the 
order in which they occur. The tabs are shown in Figure 5.18. 

Slider bar allows 
current time to 
be changed 

Time is currently 
5 minutes 
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Figure 5.18 The occurrence of event transients is recorded in the 
General Output section 

XTS analysis summary 

The transient reservoir data shows that the water in the discharge tank 
reached a height of 20 feet in 32 minutes. This is confirmed by the event 
message indicating the pump transient also initiated at this time.  

The Quick Graph plot (Figure 5.15) shows the increase in the tank liquid 
height, until the time when the pump turns off. The graph then shows 
that there is actually back flow into the system, due to the hydrostatic 
pressure of the fluid in the tank. When there is reverse flow through the 
pump, the pump head cannot be predicted, and a critical warning is 
displayed in the Output. A check valve would need to be added to the 
system to prevent this situation in the case of pump shutdown. 

SSL problem statement 

The piping for a slurry system which moves sand is being designed. The 
system will pump 25% sand by volume from an open supply vessel with 
a liquid surface elevation of 5 feet to an open receiving tank with a liquid 
surface elevation of 10 feet.  

Use the SSL module to size the pump. 

SSL Step 1. Start AFT Fathom 

From the Start menu, choose AFT Products and AFT Fathom. When 
prompted to activate modules, choose to activate the SSL module. If not 
prompted, then choose Activate Modules from the Tools menu. 
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SSL Step 2. Specify system properties 

1. Open the System Properties window by selecting System Properties 
in the Analysis menu 

2. Select Basic Water Slurry Input at the upper right (this should be the 
default selection). See Figure 5.19. 

3. Select the Detailed option for Slurry Calculation Method 

4. Enter a temperature for water of 70 deg. F. 

5. In the Solids Specifications area, select the “User Specified Solids 
Added” button 

6. Select the calculated M and Vt/Vts factor of 1 

7. Enter a solids density of 2.9 S.G. water, a d50 of 0.015 inches, a d85 
of 0.03 inches  

8. Set the Amount Solids Added to 25% by Volume 

9. Select OK 

 

Figure 5.19 Data entry for Sand slurry properties 
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SSL Step 3. Build the model 

A. Place the pipes and junctions 

At this point, the first two items are completed on the Checklist. The next 
Checklist item is to Define Pipes and Junctions. In the Workspace 
window, assemble the model as shown in Figure 5.20. 

 

Figure 5.20 Layout of pipe system for Pump Sizing for Sand 
Transfer System Example 

B. Enter the pipe data 

The system is in place, but now you need to enter the input data for the 
pipes and junctions. Double-click each pipe and enter the following data 
in the Properties window (or use the Global Pipe Editing window). 
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All pipes are Steel - ANSI, with standard roughness and this data: 

Pipe Length 
(feet) 

Size Type 

P1 20 12 inch STD 

P2 500 12 inch STD 

P3 50 12 inch STD 

C.    Enter the junction data 

J1 - Reservoir  

1. Name = Supply Tank 

2. Liquid Surface Elevation = 5 ft 

3. Liquid Surface Pressure = 10 psig 

4. Pipe Depth = 5 ft 

J4 - Reservoir  

1. Name = Receiving Tank 

2. Liquid Surface Elevation = 10 ft 

3. Liquid Surface Pressure = 30 psig 

4. Pipe Depth = 10 ft 

J2 - Pump  

1. Elevation = 0 feet 

2. Pump Model = Mass Flow Rate Fixed 

3. Fixed Flow Rate = 1,400 tons/hour of solids 

4. Slurry De-rating use ANSI/HI Standard 12.1-12.6-2005 method 

5. Impeller size is 8 inches 

J3 - Elbow  

1. Elevation = 0 feet 

2. Type = standard 
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D. Check if the pipe and junction data is complete 

Turn on “Show Object Status” from the View menu to verify that all the 
necessary data is entered. If so, the “Define Pipes and Junctions” 
Checklist item on the Quick Access Panel will have a check mark. If not, 
the uncompleted pipes or junctions will have their number shown in red. 
If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data. You can also open the List Undefined Objects window 
from the View menu to see what data is missing. 

SSL Step 4. Run the model 

Select Run Model in the Analysis menu. This will open the Solution 
Progress window. This window allows you to watch as the AFT Fathom 
Solver converges on the answer. 

After completion, click the View Output button at the bottom of the 
Solution Progress window. 

SSL Step 5. Examine the results 

The Output window contains all the data that was specified in the Output 
Control window.  

The Slurry tab shows the slurry results, as shown in Figure 5.21. Here, 
one can see that the velocity is 21.9 feet/sec, which is safely above the 
11.5 feet/sec settling velocity. Other pressure drop and relevant slurry 
data can be viewed here. 

Also shown in Figure 5.21 is the Pump Summary in the General Section. 
There, the required pump head is shown as 93.98 feet, and the de-rating 
correction factor is 0.79. Hence, a pump should be selected that can 
generate 93.98/0.79 = 119 feet of head based on water. 

Also of interest is the system curve. Select the Graph primary tab, and 
then the Graph Parameters tab on the Quick Access Panel. Then select 
the Slurry System Curve tab on the right. See Figure 5.22. 

By default, the parameter to graph is jm vs. velocity. Select the units of jm 
as ft/ft which will make it completely dimensionless as is typically done. 
Check the box for cross-plotting the water curve and then click the Show 
button. The curves are shown in Figure 5.23. 
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Figure 5.21  The Output window shows the Slurry results table in 
the center Pipes section and the pump de-rating in the 
Pump Summary in the upper General section 
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Figure 5.22 Data selection for graphing slurry system curve 
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Figure 5.23 Slurry system curve and water curve in Graph Results 
window 

SSL analysis summary 

A slurry of sand and water flowing through 570 feet of pipe was 
modeled. Total pipe head loss was determined and pump head 
requirements were calculated. A slurry system curve was created to 
allow the user to see where the system was operating with respect to 
solids settling. 
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Other AFT Fathom Capabilities 

This Quick Start Guide necessarily omitted or had brief coverage of a 
number of important AFT Fathom capabilities. This chapter briefly 
describes some of the important capabilities not covered. 

Microsoft Excel™ data integration 

AFT Fathom now includes enhanced Excel importing and robust Excel 
exporting. An Excel spreadsheet can be used to vary selected input 
parameters in multiple scenarios. Selected output can also be exported to 
specified Excel sheets and cells.  

Integration with other software and data standards 

AFT Fathom includes a number of importing and exporting capabilities. 
Piping layouts and dimensional data can be imported from GIS 
Shapefiles (SHP) to build a model. Additionally, CAESAR II Neutral 
Files (CII) can be imported into AFT Fathom and EPANET Files (INP) 
can be both imported and exported.  

Piping Component Files (PCF) from AutoCAD Plant 3D, SmartPlant, 
PDS, CADWorx, and other software can be imported into AFT Fathom. 
These options are all accessed from the File Menu. 

Control valve modeling 

AFT Fathom can model four types of control valves. They are Pressure 
Reducing Valves (PRV’s), Pressure Sustaining Valves (PSV’s), Flow 
Control Valves (FCV’s), and Pressure Drop Control Valves (PDCV's). 
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Fitting library 

AFT Fathom offers a library of about 400 fitting losses that can be added 
to pipes. 

Variable speed pumps 

AFT Fathom allows you to model controlled pumps where the control 
parameter is flowrate or pressure. The pump speed is varied to deliver 
the flow rate or pressure you set.  

Pump impeller trim effects 

AFT Fathom can automatically modify pump curve data for user 
specified impeller trims. The impeller variations can be based on a 
percentage from the specified curve or, if using multiple pump 
configurations, actual impeller dimensions can be entered. 

AFT Fathom uses standard affinity laws to modify the pump curves. 
When multiple curves are entered, AFT Fathom modifies the pump curve 
by interpolating between the curves based on impeller size. 

Pump viscosity effects 

When fluids are viscous, pump performance degrades. AFT Fathom uses 
methods published by the Hydraulics Institute for rotodynamic pumps to 
automatically adjust manufacturer pump curves. 

Model heat transfer between loops 

Heat transfer between loops which are hydraulically isolated can be 
modeled. The loops can have different fluids. This is called thermal 
linking. 

Modeling of gas flow in HVAC and ventilation duct systems  

AFT Fathom can model incompressible gas flow. AFT Fathom offers 
support for both cylindrical as well as rectangular ducts. 
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Varied pipe geometries including rectangular duct 

Five different pipe geometries can be modeled in AFT Fathom. The 
default geometry is the cylindrical pipe. The other four geometries are 
the rectangular duct, the cylindrical annulus, the noncylindrical pipe, and 
the helical tube. 

Insulation on inside of pipe/duct 

Insulation can be placed on the inside of a pipe or duct, and the effect of 
reduced flow area on the pressure drop will be automatically determined. 
If modeling heat transfer, the effect of the insulation on the inside will be 
accounted for. 

View input and output data from different scenarios concurrently 

Input data from different scenarios can be viewed concurrently in the 
Model Data window. Similarly, output data from different runs can be 
viewed concurrently in the Output window. 

Online pump manufacturer equipment selection 

AFT Fathom includes a two-way link to Intelliquip™ enabled pump 
manufacturer Internet websites to select pumps. Operating data 
determined by AFT Fathom can be passed to the website, a pump model 
selected by the user, and the pump performance data transferred back to 
AFT Fathom for immediate use in the model. 

Network databases 

Junction components and pipe materials can be saved to databases for 
later reuse. Databases can be located on local PC's or deployed across 
local or wide area networks. The Database Manager allows users to 
connect to relevant databases for their specific pipe system design. 
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Darby 3-K method for laminar flow 

The 3-K method developed by Darby can be optionally used in valves 
and elbows. This has particular application in the laminar and transition 
regions. 

Equivalent Length 

Standard equivalent lengths can be specified for pipe fittings, valves and 
elbows. This is often used in fire protection systems. 
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